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Instructions for Setting up Adobe Reader  

Using the Previous View and Next View buttons in Adobe Reader (and Adobe Acrobat) will make it 
easier to navigate the FOFEM Help; however, they are not added to the Reader toolbar by default.  

1) To turn on the Previous View button select: View > Show/Hide > Toolbar Items > Page Navigation > 
Previous View.  

 

2) To turn on the Next View button select: View > Show/Hide > Toolbar Items > Page Navigation > Next 
View.   

 

3) When you are done the Previous View and Next View buttons will be on the Reader toolbar. 
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Introduction 

FOFEM - A First Order Fire Effects Model - is a computer program that was developed to meet needs of 
resource managers, planners, and analysts in predicting and planning for fire effects. 

Quantitative predictions of fire effects are needed for planning prescribed fires that best accomplish 
resource needs, for impact assessment, and for long-range planning and policy development. We have 
developed the computer program FOFEM to meet this information need. 

Much fire effects research has been conducted, but the results of this research have tended to be 
empirical, and thus limited in applicability to situations similar to those under which the research was 
conducted. Additionally, fire effects research results have not previously been assembled in a common 
format that is easily accessed and used, but rather have been scattered in a variety of journals and 
publications. 

In developing FOFEM, we have searched the fire effects literature for predictive algorithms useful to 
managers. These algorithms have been screened to evaluate their predictions over a range of 
conditions. We also determined the conditions under which each is best suited to use by examining the 
documentation of these algorithms. Thus, a major internal component of FOFEM is a decision key that 
selects the best available algorithm for the conditions specified by a user. 

In addition to selecting appropriate algorithms for users, we have also attempted to make these 
algorithms simple to apply; this has been done by incorporating the algorithms into an easy-to-use 
computer program.  Realistic default values, documented in detail in this guide, have been provided for 
many inputs, minimizing the data required. These defaults were derived from a variety of research 
studies. Any of these default values can be overridden by the user, allowing the use of this program at 
different levels of resolution and knowledge.  

We anticipate that FOFEM will be useful in a variety of situations. Examples include: setting acceptable 
upper and lower fuel moistures for conducting prescribed burns; determining the number of acres that 
may be burned on a given day without exceeding particulate emission limits; assessing effects of 
wildfire; developing timber salvage guidelines following wildfire; and comparing expected outcomes of 
alternative actions. 

A new version… 

FOFEM6 replaces its two predecessors; FOFEM4 an IBM-PC DOS version developed in the early 1990s 
and FOFEM5 an IBM-PC Windows version developed circa 2000.  

FOFEM6 is functionally equal to FOFEM5 but sporting a much improved GUI, graphs and a few other 
updates please see:  Updates 

Overview 

First order fire effects are those that concern the direct or indirect or immediate consequences of fire. 
First order fire effects form an important basis for prediction secondary effects such as tree 
regeneration plant succession, and changes in site productivity, but these long-term effects generally 
involve interaction with many variables (for example, weather, animal use, insects, and disease) and are 
not predicted by this program. Currently, FOFEM provides quantitative fire effects information for tree 
mortality, fuel consumption mineral soil exposure, smoke and soil heating. 
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FOFEM is national in scope. It uses four geographical regions: Pacific West, Interior West, North East, 
and South East. Forest cover types provide an additional level of resolution within each region. 
Geographic regions and cover types are used both as part of the algorithm selection key, and also as a 
key to default input values. 

System Requirements  

FOFEM6 will run on any IBM compatible PC using Windows XP, 7, 8 or 10.   

Installation 

The FOFEM installation package can be downloaded from the Science Applications page on the Missoula 
Fire Sciences Lab website: www.firelab.org.   

1. Download the installer package to a folder of your choice and unzip the contents of the file. 

2. In Windows Explorer or My Computer navigate to the folder of unzipped FOFEM installation 
files. Double-click Setup.exe. 

3. Click Next in the Setup Wizard window. 

 

4. Click Next in the Select Installation Folder window.  

 

 

 

 

file:///C:/Users/dlutes/Documents/Duncan/FOFEM/FOFEM_User_Guide/www.firelab.org
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5. Click Next in the Confirm Installation window. 

 

6. A progress bar will be displayed as FOFEM in being installed. 

 

7. Click Close when the installation is complete. 
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Files will be placed in two folders: 

C:\Program Files\FOFEM631 – program executable files 

C:\Users\Username\AppData\Local\FOFEM6.3.1 – reference files and user files. 

These files are added to the user folder when FOFEM is run the first time: 

 fofem.ini – Initialization file. 

 Path-FOFEM.bat – Batch file to set the path to the FOFEM install folder. Used when running 
FOFEM from the command line. 

 FOF_SPP.DAT – Links to species codes, mortality equations, bark thickness equations, region and 
crown coefficient. Space delimited. 

 FOF_NVCS.CSV – Default fuel loading for NVCS types. Comma delimited. 

 FOF_FCCS.CSV - Default fuel loading for FCCS fuelbeds. Comma delimited. 

 FOF_FLM.CSV - Default fuel loading for FLM classes. Comma delimited. 

 FOF_SAF.CSV - Default fuel loading for SAF/SRM types. Comma delimited. 

 fofem.prj – Project file of saved settings. 

 Emission_Factors.csv – Not currently enabled. Emissions factors. Comma delimited. 

 FFI_Sample.Tre – Example FFI export file that includes tree data for mortality simulations. 

 FFI_Sample.FFI - Example FFI export file that includes fuels data for consumption, emissions and 
soil heating simulations. 

 

A good place to get started is Getting Started. 

Features  

 Graphics: Graphs are available for each of the major fire effects categories:  tree mortality, fuel 
consumption, smoke, and soil heating.  The graphs can be viewed in their respective graph 
windows and also be saved to file, printed or copied into the system clipboard.  

 Reports: reports are available for fuel consumption, emissions, soil heating and tree mortality. 

 Files: FOFEM provides a variety of options for saving data to files; include graphs, reports and 
other calculated outputs.   

 Fuel Types: FOFEM provides default fuel loadings for SAF/SRM cover types; NVCS cover types 
and FCCS and FLM types. 

 Batch Processing: Multiple plots can be processed using input text files. See Batch Processing 

NOTE: FOFEM can also be used to run batch files from the system command line 
circumventing the GUI completely. 
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Modeling Approach 

In developing the decision key to select algorithms, we were guided not only by the conditions under 
which an algorithm was developed, but also by a need to develop a model without sharp discontinuities 
or inconsistencies. This made algorithm selections in some cases a judgment call and it also led to the 
exclusion of some algorithms that may have performed well but in very restricted situations, or that 
require inputs not easily available to managers.  Details about algorithms and their sources are 
documented in the Scientific Content sections of this guide. 

FOFEM6 Authors 

Duncan Lutes, Fire Ecologist, Missoula, MT 
Robert Keane, Research Ecologist, Missoula, MT 

FOFEM6 Technical Contact 

Duncan Lutes  
Fire Modeling Institute 
Missoula Fire Sciences Laboratory 
5775 US Highway 10 West 
Missoula, MT 59808 
Email: dlutes@fs.fed.us 

Acknowledgements 

FOFEM development was funded by the USDA Forest Service, National Interagency Fuels Technology 
Transfer team (NIFTT). Development support was provided by USDA Forest Service Rocky Mountain 
Research Station, Missoula Fire Sciences Lab and Fire Modeling Institute; USDA Forest Service, Fire and 
Aviation Management; Systems for Environmental Management and NIFTT  

Modifications were funded by USDA Forest Service, Research and Development program. Development 
support was provided by the USDA Forest Service, Rocky Mountain Research Station, Missoula Fire 
Sciences Lab and Fire Modeling Institute; and USDA Forest Service, Fire and Aviation Management 

We would like to thank Larry Gangi, Jeff Jones, Jim Reardon, Sharon Hood and Tom Waldrop for their 
help with FOFEM6. We add them to the list of previous FOFEM contributors: Jim Brown, Wendel Hann, 
Dan Jimenez, Scott Mincemoyer, Kevin Ryan, Melanie Miller, Gaylon Campbell, Roger Hungerford,  
and Deb Tirmenstein. Courtney Couch provided the artwork used on the FOFEM splash screen. 

 

 

 

 

 

 



FOFEM 6.3 User Guide 

11 
 

Getting Started 

When you start FOFEM for the first time it will open using the default project file (with a PRJ extension), 
which is stored in your user folder (C:\Users\username\AppData\Local\FOFEM6.3). You can choose a 
different project folder by selecting File>Save Project and navigating to a different directory. At any time 
during a FOFEM session you can save all of your settings to a file by selecting File>Save Project. Any 
number of project files can be saved.  
 

 
 
The directory path to your project is shown at the top of the FOFEM user interface. 

 
 
To create a report or graph make the desired settings for cover type, fuel moisture, etc. then click the 
desired button located on the right or left side of the user interface.   
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Report text can be moved into electronic documents using Copy/Paste commands. To copy report text, 
highlight the desired text, right-click in the report window and select Copy.  Then open your document 
and use the paste command to move the selected text. You can also print reports. 

 

 
Graphs can also be copied or printed using right-click commands. 
 

 
 

Setting a Work Folder 

Your work folder is the folder that contains your active project file. When you start FOFEM your work 
folder using the last project file you were working with.  The work folder path and project file name are 
always shown at the top of the user interface. The suggested work folder path is: 
C:\Users\username\AppData\Local\FOFEM6.3. 

 There are two ways to set your work folder, under the main menu option Project:  

1. Open Project  - opens a project file 
2. New Project - creates a new project file 

If you move to a different folder when doing one of the above you will change your work folder.  
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Select File>New Project from the main menu. 

 

 

Select a project name and directory for your new project and click Save.  

 

 

The project name and file path will be displayed at the top of the user interface. 

 

General Rule 

You should always check all of your screen settings before creating any report or graph. Whenever you 
make a change to a screen setting it can affect other screen settings or values, for example changing 
Moisture regime effects percent moisture for four fuel components. Some user entered values may also 
change or remain the same as other settings are changed and adjusted. This document attempts to 
explain the rules, but the easiest rule to remember is the one mentioned above – always review all of 
your screen settings before you create a reports or graphs. 
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Getting Help 

FOFEM has a variety of ways for you to get help. Most of the controls on the main window have a small 
Tool Tip textbox that will appear when you move and hold the cursor over them.   

 

 

The F1 function key can also be used to give you more detailed help.  Mouse click on the screen control 
you are interested in (for example, in the Cover Type field.), hit the F1 key and a small dialog box will pop 
up with the help text in it.  

 

 

This document is the third source of help. Aside from just explaining how to use FOFEM it contains other 
content such as modeling approach, scientific content, and references.    

Open & Save File Window 

Whenever you save or open a file in FOFEM you’ll be using a window like the one shown below, the only 
difference being the title and the file type(s). The example shown below is for opening a project file, 
which uses the file PRJ extension. The window allows you to navigate to folders, create folders, etc., it 
also selectively shows you particular files types.  

 



FOFEM 6.3 User Guide 

15 
 

Main FOFEM Window 

Main Window 

The FOFEM window has three sections: 

1. The upper section contains the main menu and FOFEM header dropdown list. See Main Menu - 
File, Main Menu – Options,  and  FOFEM Header 

2. The middle section contains the Fuel-Smoke-Soil Tab and Mortality Tab. Click on the tab for the 
model you wish to run, the screen shot below has the former tab selected.  

3. The bottom section contains buttons for creating reports and graphs, and a large text area 
where the reports are placed.  Graphs are opened in a separate window and can be copied, 
saved or printed.  
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Main Menu - File 

 

 A project file is a snapshot of all the FOFEM screen settings captured directly from the screen and saved 
to a file. This is done by using the Save Project menu item. By saving your settings in a project file you 
can restore them at any time by using the Open Project menu item. Any number of project files can be 
saved. Your active (current) project file is always shown in the Project File field.  The folder that contains 
you active project file is you Work folder. The Work folder is your default folder for opening and saving 
files. 

Open Project: Open a project file. The Work folder will get set to the folder where the project file is 
located. If you go to a different folder to open a project file, it will become your new Work folder and 
it will be shown in the Project File field. 

Save Project: Save will only save your screen settings to a project file, it will not change your Work 
folder setting. However you can save project files to any folder you choose.  

New Project: Save the screen setting to a project file and in addition place the project file’s folder 
and name in the Project File field 

Exit: Exit FOFEM. Make sure you save any of you work of project file before you exit. 

Main Menu – Options 

Batch Processing: Run FOFEM models using input files with multiple plots. See Batch Processing for 
details. 

Save Burnup Emission File: The Burnup model in FOFEM can produce a smoke emissions file, which 
can be exported to a spreadsheet for graphing. The file is a text file and shows emissions across time. 
Before using this option you will need to check the Smoke Analysis Type check button. See Sample 
Burnup Output Files 

Create Sample Burnup Input File: See notes above for menu item Run Burnup from Input File.  See 
Sample Burnup Input File 

Run Burnup from Input File: This option lets you run Burnup from an input text file to create two 
output files. Output files show predicted fuel consumption and smoke emissions. You can create a 
sample input file by using the Create Sample Burnup Input File menu item below.  For more details 
see Running Burnup from an input File  

NOTE:  This option can also be run from a command line prompt. The input and output file 
formats are the same as those mentioned above. To run this option, at the command line prompt 
type the following: 

>>  FOF_GUI  Burnup   inputfile   outputfile   outputEmission   outputErrors 

Following the program name the key word ‘Burnup’ is used, followed by the four files names.  
Depending on the folder you are attempting to run from you may have to set a system PATH 
variable to the FOFEM executable file in its install folder.  
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Create Sample Soil Input Files: Create sample files for the Duff model and the Zero Duff model. Two 
types of files are created based on duff loading. If there is no duff the sample file will have a .exp 
extension and will run the no-duff soil heating model. If duff load is greater than 0 the example file 
will have a .duf extension and will run the duff soil heating model.  See Running Soil Heating from 
Main Menu for more details.  

Run Soil from Input File: This option lets you create a soil heating graph and report using a text file as 
input. The Graph window will appear first, use the View menu item to switch over to the Report 
window.  You can create sample input files for templates using the Create Sample Soil Input Files 
menu item below. The samples files contain comments to explain the file contents. See Running Soil 
Heating from Main Menu for more details  

Save Soil Temp Points File: Creates a text file containing a table of temperature values. This file can 
be used with other graphing software. Before using this option you will need check the Soil Analysis 
Type check button and create a soil graph. For more details see Output Graphing File  

Settings: This window allows you to change units for emissions and change other simulation settings. 
These settings are not saved in the project file.  

NOTE: If non-default settings are desired they must be set every time FOFEM Is opened. 

Emissions Output Unit – Set units in the Smoke Emissions report. Available units are lbs/ac 
(default), Tons/acre or g/m2 

Duff Heat Production Source – Set heat content of burning duff.  

Production Source Heat of combustion 
(Mj/kg) 

Note 

PeatLow 15 Used in previous versions of FOFEM 
PeatHigh 20  
DuffLow 25  
DuffHigh 30  

Values based on: Frandsen, W.H. 1991. Heat evolved from Smoldering Peat. Int. J. Wildland Fire l(3): 
197-204 

Heat Efficiency – The proportion of heat intensity that is directed to the soil for determining soil 
heating. There are the components that Duff, W/L (woody fuels and litter) and H/S (herb and 
shrub). Default values provided next to each field are the values used in previous versions of 
FOFEM. 

Duff Reduction Equations – When the box is checked FOFEM calculates the amount of duff 
consumed using equation 6 (% duff consumption) instead of equation 2 (duff depth consumed). 
See Scientific Content-Fuel Consumption-Duff Consumption for more information.  

FOFEM Header 

Project File 

The Project window displays the active (current) project file.  

The window also lets you know what your Work folder is by showing the full folder path.  
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Region 

The region you select will determine the availability of cover types and tree species, and which 
consumption and mortality equations are used.  

 

Select a region that is appropriate for you project.  

1. Interior West 
2. Pacific West 
3. North East 
4. South East 

Fuel-Smoke-Soil Tab 

This tab located on the main FOFEM window contains all of the inputs needed to calculate fuel 
consumption, smoke/emissions and soil heating outputs.  

Settings 

 

 

Cover Type:  The smaller dropdown list field contains the Cover Type Classification and the larger 
dropdown list field contains the fuelbed code and name.    



FOFEM 6.3 User Guide 

19 
 

NOTE: Only cover types that are relevant to the Region you have selected will be loaded.  

Season:  For setting the of the burn: Spring, Summer, Fall, Winter. The selection of some FOFEM 
model equation is dependent on the season selection. See Decision Dependency.  

Fuel Load: The dropdown list on the left let you set the whether the fuels were Natural or Slash. The 
selection modifies of the fuel loading of the fuel components to the right.  Depending on the cover 
classification you have selected, not all cover types will have adjustments. See Cover Type 
Classification. 

Duff, Litter, 0-1/4, … Branch:  These are the individual fuel loadings for the cover type you have 
selected are placed in this row of textboxes. The values can be individually adjusted with a right 
mouse click in the textbox. The shading of each textbox reflects how it has been adjusted. For 
reference see the shading of the adjustment buttons on the far right hand side of the row.  A white 
textbox indicates that a User value has been entered.  

Adjustments:  Clicking these buttons will adjust fuel loadings for each of the fuel components.  The 
number of buttons shown is dependent upon the selected cover classification. The single letter on 
each button indicates the adjustment - Light, Typical and Heavy 

Depth: duff depth, this value is based on the selected cover type and is editable by the user. 

% Rotten:  the amount of 3+ inch fuel that is rotten.  

Distribution:  3+ inch log loading distribution, see the Distribution table. 

% Consumed:  the amount of Foliage and Branch fuels that you want to be consumed will be based 
on this percentage.   

NOTE: the entered percent is directly applied to the foliage, but only 50 percent is applied to 
branch. That is ….for decimal percentage N, then Consumed foliage = foliage load * N, Consumed 
Branch = branch load * ( N * 0.50 )  

Moistures:  default moisture regimes are available in the dropdown: Wet, Moderate, Dry, Very Dry. 
The values are user editable by highlighting the value in the textbox and typing in a new value. See 
Moisture Regime.   

NOTE: When the duff moisture is set to its lower limit (10%) all of the duff will be consumed 
regardless of what FOFEM’s assigned duff equation predicts. This is helpful when doing soil 
simulations, in that it will force all of the duff to be consumed, allowing the fire’s heat to reach 
the soil; otherwise any remaining duff will act as an insulator.   

NOTE: Litter, 0 -> ¼ and 1->3 inch fuel moistures needed to calculate consumption are computed 
by FOFEM based on the ¼ -> 1 moisture value.  

Output:  select the calculated values you want shown in the textboxes at the right: Consumed, Post, 
Consumed %. This setting does not affect the reports or graphs.  

Soil Moist / Type:  this setting modifies heat transfer through the soil and can be set to these soil 
families: Loamy Skeletal, Fine-Silt, Fine, Coarse-Silt, Coarse-Loamy. Soil moisture is user editable by 
highlighting the value in the textbox and typing in a new value.  If you aren’t interesting in soil 
heating outputs then these settings are not used for simulating consumption or emissions.   
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Cover Type Classification 

 Set this box according to the cover type classifications you want to use.  

 You have four choices.  

1. SAF/SRM – Society of American Foresters/Society for Range Management 
2. NVCS – National Vegetation Classification System 
3. FCCS – Fuel Characteristic Classification System    
4. FLM – Fuel Loading Models 
 

Selecting FCCS or FLM cover type will cause the low (L) and high (H) fuel load adjustment buttons to 
disappear because these classes do not have adjustment codes associated with them.   

NOTE: FCCS coarse woody fuel loadings, unlike other classes are stored (see fof_fccs.csv file), in 
three separate size classes (3–9 in., 9–20 in., and >20 in., plus sound, and rotten).  When the 
Cover Type classification is set to FCCS FOFEM shows one total 3+ loading on the user interface 
along with a calculated rotten percentage and a “Fixed’ log load distribution but when fuel 
consumption is calculated the individual size classes are used behind the scenes. If you do choose 
to change an FCCS fuel load, percent rotten or log load distribution, FOFEM will simply resort to 
normal operation, using the percent rotten and log load distributing as shown on the screen.     
NOTE: The list of FCCS fuelbeds and associated component fuel loads was current as of 9/2012. 
For more information about FCCS see http://www.fs.fed.us/pnw/fera/fccs/.   

 

NOTE: For more information about FLMs see: 

Lutes, DC; Keane, RE; Caratti, JF. (2009). A surface fuel classification for estimating fire effects. 
International Journal of Wildland Fire 18: 802-814  

Sikkink, Pamela G.; Lutes, Duncan C.; Keane, Robert E. 2009. Field guide for identifying fuel 
loading models. Gen. Tech. Rep. RMRS-GTR-225. Fort Collins, CO: U.S. Department of Agriculture, 
Forest Service, Rocky Mountain Research Station. 33 p. 

Outputs 

The bottom half of the Fuel – Smoke – Soil window is where you produce reports and graphs.  
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To create a Report click any one of the buttons on the left and a report will be placed in the Report 
window.  Each time a button is clicked a new report is added to the end of the report, scroll down in the 
text window to see it. You can use a right mouse click to Copy,  Cut, Paste, Print, Save or Clear.  

 

Report Totals:  This box allows you to report results from multiple FOFEM simulations in an easier to 
read table format.  To save simulation results type a name in the textbox and click one of the report 
buttons. Repeat to save successive reports. When you have completed all the simulation you want to 
compare click the Write button and the results will be placed into the report. Hit the Clear button to 
clear all of the stored totals.  

 

To create a Graph click the buttons on the right side and a window will pop up with the graph. You can 
leave the graph windows open and watch them change as you modify your inputs on the main window. 

Fuel Consumption Graph 

 

The graph shows the pre-burn load, the amount consumed and the post-burn load amount.  

 

Fix Axis:  The graph will readjust the Y axis whenever you change an input on the main window. You 
can prevent this from occurring by clicking this checkbox. This can be handy if you are trying to 
compare outputs.  Clicking the box will freeze the scale of the Y axis. Uncheck the box and the FOFEM 
will set the axis automatically.   
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Smoke Emissions Graph 

 

The graph displays the rate which components are being emitted.  By selecting the checkboxes on the 
left you can show one or more of the emission components.  

Set Axis Limit: To limit the X or Y axis, enter a number in the textbox and hit the return key. If no 
values are entered FOFEM will automatically set them 

Rotate Axis:  The graph can also be rotated on either or both axis using the up/down boxes.   

Soil Heating Graph 
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The graph shows soil temperatures (Celsius) for each layer across time (minutes), with each layer 
representing one centimeter. By selecting the checkboxes on the left you can show one or more of the 
soil layers (each layer is one centimeter in thickness). The intensity graph at the bottom displays 
intensity at the soil surface over time. When there is duff present the intensity comes entirely from the 
burning duff. When there is no duff present then intensity is simulated as a proportion of the total 
woody fuel, litter, herb and shrub combustion intensity. 

Post Fire Duff Depth: Specifies the amount of duff depth that is remaining after a simulated fire.   

Max Temp xx @ min xx: The maximum temperature and the time in minutes that it was reached. 
This number represents the layer closest to the surface that is selected (checked) in the layer 
checkboxes.  

Lines:  Selecting this checkbox will show the graph in line form. 

Y Axis, X Axis:  Used to limit the axis enter a number and hit the return key, otherwise FOFEM will 
automatically set them. 

NOTE: when doing soil heating simulations you should be aware that the amount of duff 
consumed is an important factor and that some duff reduction equations may never allow 
complete combustion of duff. However, FOFEM allows you to force duff consumption of 100 
percent – please see notes related to moisture and duff. 

Fire Intensity Graph 

The values used to produce this graph come directly from the Burnup model. 

 

X Axis, Y Axis:  to limit the axis enter a number and hit the return key, otherwise FOFEM will 
automatically set them. In the above example a user value of 25 was entered.  

Fuel Consumption Report 

The top section of this report shows the input settings that you have selected for Region, Cover Type, 
etc.   The next section of the report shows each fuel components. For the 3+ inch fuel loading each 
individual size class is shown as well as total, the size classes are broken up according the Log 
Distribution setting you selected on the main window.  If you adjusted any of the fuel loadings you will 
see the characters “u”, “+”, or “-“ to designate the type of adjustment as noted at the bottom of the 
report.   
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The equation number 999 indicates that the Burnup model was used to compute the consumption 
values.  

 

 

 The bottom section of the report contains the fire effects on the forest floor and carbon loadings. 
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Smoke Emission Report 

Emission amounts for each component are shown for flaming and smoldering in pounds per acre.  

NOTE:  NOX emissions are only generated during the flaming period of fuel consumption. 

 

 

Soil Heating Report 

Soil Layer Maximum Temperature:  the table shows the maximum temperatures that were reached at 
each layer.  

 

Depth: Layers are in one centimeter increments starting with the surface being 0  

Temp: The maximum temperature (Celsius) that the layer reached  

Time: How many minutes it took to reach the layer’s maximum temperature 

NOTE: The number 1 means that no heat from the fire reached the layer as shown at the 13 cm 
layer. 
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Max Depth Having 60/275 degrees:   the deepest layers to reach 60 and 275 degrees. This example 
shows that the deepest layer to reach 60 degrees was 7 cm. This example also shows that there were 
no layers reaching 275 degrees, including the surface, so the word “None” is shown. 

Summary Report 

Summary reports provide an quick way to compare simulation results at various prescriptions. The 
example summary report shows totals taken from two smoke emissions reports (because emissions are 
closely tied to consumption a fuel consumption summary report is included with the emissions summary 
report).  

 

The example was created simply by running two emissions reports and naming each based on the 
moisture regime setting selected. The first report was run with the title “VeryDry” entered in the 
Summaries field on the user interface. The second emissions report was titled “Dry”. The summary 
report was produced by clicking the Write button.   

Mortality Tab 

Settings – “Pre-fire” 

The “Pre-fire” report and graph are used when you want to simulated mortality before a fire has taken 
place, for example, when determining a burn prescription for a prescribed fire. All input fields are 
required. 

 

The Mortality tab shown above is located on the main window next to the Fuel – Smoke – Soil tab. All of 
the settings needed to do a report or graph are on this tab.  

Species: Make a selection from the species dropdown list and use the arrow button to populate the 
species textbox in the data grid.  

NOTE: Only the species available for the selected region are available in the dropdown list.  You 
can also type the species code directly into this box.  
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Density:  Trees per acre 

DBH:  Diameter breast height in inches 

Height:  Height in feet 

C/R:  Crown ratio/10. Valid values:  1 – 10.  

Graph:  Select the checkbox for one or more species to be graphed 

Flame Length / Scorch Height:  Enter the value in feet and check the appropriate radio button.  

Low Fire Severity:  Check this box for a low fire severity condition (currently only used for aspen 
mortality). 

Post Fire Injury:  Check this box if you want to do post fire injury mortality   

NOTE: See Settings – “Post Fire” for instructions using the post-fire mortality simulation.  

FFI File:  This button allows you to import tree data exported from the FFI software.  The imported 
plots will be shown in the Plot--> dropdown list. Select the desired plot and the tree information will 
be loaded directly into the tree data grid. Tree records missing required data will not be displayed. 
The count of records with missing data is displayed in the Errors field. Check the Load All checkbox to 
see all records. Missing data will be displayed as -1 in the data grid. Click Close to erase records in the 
data grid. 

NOTE: See the FFI user guide for information about exporting data.  

To delete a row from the data grid, highlight the row by clicking the gray area to the left of the Species 
column then hit the Delete key on your keyboard.  

If desired, save your settings to a project file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

file:///C:/Users/dlutes/Documents/Duncan/FOFEM/FOFEM_User_Guide/Post%23_Settings_–_
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Mortality Report – “Pre-fire” 

This report includes five tables and summarized mortality information. 
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Original Stand Density: The pre-fire stand data reported by species and diameter class. 

Post-fire Stand Density: The post-fire stand data reported by species and diameter class. 

Tree Killed by Fire: The trees killed by the simulated fire reported by species and diameter class. 

Probability of Mortality: This table shows the probability of mortality of the trees included in the 
simulation and the Mortality Equation Number and Mortality Equation Name used to predict the 
mortality. 

NOTE: Not all tree species have species specific mortality equations so review the equations used 
for the species in your simulation. See Estimating Tree Mortality - “Pre-fire” 

Average Mortality Probability by Species /Diameter: The table shows the probability of mortality at 
a variety of crown scorch or flame lengths (as set on the Mortality tab) for the species/DBH 
combinations entered in the data grid. 

Stand Tree Mortality: Summary information for the simulation. 

Mortality Graph - “Pre-fire” 

The mortality graph shows all of the species where the Graph box is checked in the species grid. The X 
axis variable graphed as Flame Length or Crown Scorch as set by the user on the Mortality tab.   
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Settings – “Post Fire” 

The “Post-fire” report and graph are used to simulate tree mortality using information sampled from 
individual trees after a fire has occurred.  All input fields are required. 

NOTE: Post fire injury simulation is not currently available in the FOFEM batch mode. FOFEM does 
not support FFI data import for post-fire mortality simulation. 

 

 

Species: Make a selection from the species dropdown list and use the arrow button to populate the 
species textbox or you can type a valid code directly into the Species field.  

NOTE: Only the species available for the selected region are available in the dropdown list, and 
not all regions currently have species available for them.  

Density: Enter the tree density in trees per acre  

Crown Dam %: This is a value from 0 to 100 based on either percent crown length scorched, percent 
crown volume scorched or percent crown with bud kill.  

If the first variable in parenthesis following the species name in the species selection window is len 
then input the percent crown length scorched in the Crown Scorch field. If the first variable in 

parenthesis in vol then input the percent crown volume scorched. If the first variable in parenthesis 

in kil then input the percent crown volume killed (percent buds killed). For example, in the screen 
shot above the species ABCO is selected so the crown scorch should be based on scorch length. 

NOTE: Crown volume killed is used only in post-fire mortality equations for ponderosa pine and Jeffrey 
pine. When selecting these species on the Mortality tab you will see two sets of equations. Species 
symbols that end in “k” require percent crown killed in the Crown Scorch field and the species symbols that 
don’t end in “k” require percent crown volume scorched in the Crown Scorch field. For example, the 
equation linked to PIJEK uses percent crown killed and the equation linked to PIJE use percent volume 

scorched. 

 

DBH: Diameter at breast height in inches.  

Cambium Kill Rating: Cambium Kill Rating (CKR) is a value from 0 to 4 and is the number of dead 
cambium samples found at the tree’s base based on 4 samples evenly spaced around the tree bole. 

CKR is used in all post-fire mortality predictions 

Beetle Y/N: Y= the tree was attacked by beetles; N= the tree was not attacked by beetles. See the 
individual mortality equations in the Mortality Equations –“Post-fire” section for more information 
about beetle species used in the models.  
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If the fourth variable in parenthesis following the species name in the species selection window is X 
then beetle attack is not used in the mortality equation and the Beetle field in the data grid must be 
set to “X”. If the fourth variable in parenthesis is btl then enter “Y” or “N” in the Beetle field in the 
data grid. 

Graph: Use these checkboxes to indicate the species that you want to graph  

Probability Mortality Cutoff:  Enter a value between 0 and 1. This value determines how the STAND 
TREE MORTALITY…   section of the mortality report is formatted. Trees with probability of mortality 
values greater than or equal to the entered cutoff are predicted to die. Trees with probability of 
mortality values less than the cutoff are predicted to live. 

FFI File:  This function is not available when using the Post-Fire equations. 

Mortality Report - “Post-fire” 

Post-fire injury reports differ somewhat from pre-fire reports. Below is an example showing the 
probability section of a post-fire report. 
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This report includes five tables and summarized mortality information. 

Original Stand Density: The pre-fire stand data reported by species and diameter class. The second 
table is a continuation of the first so large DBH trees can be included. 

Post-fire Stand Density: The post-fire stand data reported by species and diameter class. There are 
two tables with the second table is a continuation of the first so large DBH trees can be included. 

Tree Killed by Fire: The trees killed by the simulated fire reported by species and diameter class. 

Probability of Mortality: This table reports the data entered in the data grid, the probability of 
mortality of the trees included in the simulation and the Mortality Equation ID and Mortality 
Equation Name used to predict the mortality. 

NOTE: Not all tree species have species specific mortality equations so review the equations used 
for the species in your simulation. See Estimating Tree Mortality - “Post-fire” 

Average Mortality Probability by Species /Diameter: The table shows the probability of mortality at 
different levels of crown scorch for the species/DBH combinations entered in the data grid. 

Stand Tree Mortality: Summary information for the simulation. 

Graph – “Post-fire” 

Predicted probability of mortality is shown by crown scorch. The horizontal red line marks the mortality 
probability cutoff value you entered. All trees with calculated probability of mortality values greater 
than the entered cutoff are predicted to die. All trees less than the entered cutoff are predicted to live. 
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Batch Processing 

FOFEM contains a batch mode for processing multiple plots using input files. Each one of the four 
FOFEM models is available.  Batch files can be processed in either one of two ways: 1) Using the user 
interface or 2) From a system command line prompt. Each procedure is explained below.  

 

Batch runs using the user interface 

1. Open the FOFEM Batch File Dialog Box from the main menu Options->Batch Processing 

2. Select a Model Type by clicking the radio button immediately preceding the model name: 
Consumed Emissions, Consumed Emission Soil or Tree Mortality.  

3. Select a batch input file by clicking the Input button. 

4. Set the Output File name. A default file name will be shown based on the selected input file 
name, you can use the default path and file name or edit it.  The Error File name will be 
generated by the program based on the input file name.  

5. Click Yes or No to put column heading labels into your output file. You have the option of 
putting a single row of column labels to the top of your output file. The labels are abbreviations 
for each column of output data and are helpful if you are going to import the data into a 
spreadsheet or database.   

6. Click Run to process.  
 

The number of stands/plots run from the input file will be displayed in the Stands field.  

The number of errors encountered in the input field will be displayed in the Errors field and the error 
messages will be placed in the error file.    

 NOTE: You can create a sample input file by selecting a Model Type and then clicking the Sample 
button. The sample file includes comments and notes about inputs and other features you might 
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choose to use. For example, placing the #Emission-File text switch in the file will cause FOFEM to 
generate individual emission files for each plot of data listed in the batch file.  

The output file is in comma delimited format. The column headers are defined in the Batch Output File 
section. 

Batch runs using the system command line prompt 

The FOFEM6 batch command line option was designed to allow the program to be run in situations 
where a user interface is not relevant or not allowed by the system or application that it is running 
under. All of the program’s output, including errors, will be written to text files (the program will 
attempt to pop up a Windows dialog box if it detects any command line program arguments).  A sample 
input file can be created in the FOFEM Batch window as described in the previous section of the user 
guide. 

When running FOFEM in a command window (DOS window) you need to set a system PATH variable in 
order for the system to find the FOFEM executable in its installation folder. Setting the Path variable will 
allow you to run FOFEM in batch mode from any directory (e.g., your working directory: 
C:\Users...FOFEM6.3.1).  

Running Path-FOFEM.bat file – found in the C:\Users …FOFEM6.3 .1 folder - will automatically set the 
Path variable. To run the file, simply double-click on the filename in Windows Explorer or My Computer.  

Optionally, you can open a command window and type the Path variable at the prompt:  

set path=%path%;C:\Program Files (x86)\FOFEMFolder  

where FOFEMFolder is the name of your FOFEM installation folder in the C:\Programs Files (x86) folder 
(e.g., FOFEM631).  

At the command prompt type FOF_GUI ?  to display the DOS options for running FOFEM. 

NOTE: The Emissions_Factors.csv file must be in the same folder as the Infile. 

1. Open a command window and at the command prompt enter the string to run FOFEM using the 
following syntax:  

             > FOF_GUI   C | S | M  infile  outfile  runfile  errorfile  [H] 

Select one of the following as the first argument: 

    C = Consumed/Emissions model 

    S = Consumed/Emissions/Soil model 

    M = Mortality model 

Set input and output file names: 

Infile = standard batch input file for the selected model type to be run 

NOTE: Only the infile is an input file, the other three files are created when the program 
is run. 

outfile = batch output file created by program, contains calculation values 

runfile = upon completion this file is created and contains number plots processed, number of 
errors, and file names 

errorfile = any error or warning messages  
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          H = is an optional argument, when present column heading labels will be placed in the outfile 
 

2. When program is complete, you should check the error file to see if any errors were 
encountered, the run file also contains the number of errors.  

Example FOFEM Command Line Text 

In the example screen shot below the first command sets the Path variable and the second runs FOFEM 
using a Consumed/Emissions input file. The input file is named ConE-In.txt, the output files that are 
created when FOFEM runs are ConE-out.txt, ConE-run.txt and ConE-err.txt. The H option is used to add 
headers in the ConE-Out.txt file. After FOFEM executes the output files can be open with a text editor. 

 

Batch - Consumed Emission Soil  

Batch Input file - Consumed Emission Soil 

Batch input files use a comma delimited format. Numerical fields can be an integer or a floating point 
number. Text fields must be contained within double quote marks (e.g., “Spring”, “Entire”).  In addition, 
comment lines can be created by placing a “#” in column one. Blank input lines found in the input file 
will be ignored.   

NOTE: In FOFEM batch input files lines that are comments begin with a “#” followed by a space 
and then the comment text. Lines that are switches begin “#”, followed immediately by the name 
of the switch. For example: # FOFEM example file is a comment. #1k-SizeClass is a switch. See 
Example Batch Parameter File 

No output record will be created for any input record that contains any errors. If an unusually large 
number of error messages occur while you are processing a file you should check the input file format 
and also make sure that you have selected the proper Model Type for the input file you are using. Model 
Type is selected at the top of the FOFEM Batch window. The options are: Consumed Emissions, 
Consumed Emission Soil and Tree Mortality.  

There is a button on the FOFEM Batch dialog box for creating sample batch input files. The sample files 
are specific to each Model Type and contain comments and column headings to aid you in formatting 
your own files.  

 

Each row of input data represents one plot and will produce one row of output.  All columns shown in 
the Batch File Description table below are numeric unless specified as text.  

 

 



FOFEM 6.3 User Guide 

36 
 

Batch File Description table 
For Consumed Emissions and Consumed Emission Soil Model Types 

Column No. Field Name                 Description 

1 Plot Id              Text or numeric, this field can be entered with or 
without delimiting double quote marks. Do not use 
embedded blank characters, for example use "Ridge-
1" instead of “Ridge  1” 

2 Litter Litter fuel load (T/ac) 

3 1 Hour Loading of  0 – ¼ in. fuels (T/ac) 

4 10 Hour                     Loading of the ¼ - 1 in. fuels (T/ac) 

5 100 Hour                    Loading of the 1 – 3 in. fuels (T/ac) 

6 100 Hour Moisture Moisture of the 100 hour fuels; range: 3 - 298% 

7 1000 Hour1                   Loading of the greater than 3 in. fuels (T/ac) 

8 1000 Hour Moisture             Moisture of the 1000 hour fuels; range: 1 - 300% 

9 1000 Hour Percent 
Rotten 

Percent of 1000 hour load that is rotten, expresses as 
a whole number; range  0 - 100% 

10 1000 Hour Weight 
Distribution2   

Defines how the 1000 hour fuel is distributed into 
size classes; “Even”, “Right”, “Left”, “End”, “Center” 

11 Duff                                Duff Loading; range 0 - 356.79 T/ac. 
NOTE: if duff loading is 0 then duff depth must 
be 0 

12 Duff Moisture                 Duff moisture; range 10 - 197.2%   

13 Duff Depth                     Duff Depth, inches; range 0 – 999 in. 
NOTE: if duff depth is 0 then duff loading must 
be 0 

14 Duff Moisture Method3 The method used to measure duff moisture;  
“Entire”, “Lower”, “NFDR”, “Adj_NFDR” 

15 Herbaceous    Herbaceous fuel load (T/ac) 

16 Shrub     Shrub fuel load (T/ac) 

17 Crown Foliage                Crown Foliage fuel load (T/ac) 

18 Crown  Branch               Crown Branch fuel load (T/ac) 

19 Percent of Crown Burn   Percent of crown that will burn, expressed as a 
whole number; range 1 – 100% 

20 Region                           “InteriorWest”, “PacificWest”, “NorthEast”, 
“SouthEast” 

21 Cover Group                   See the Setting Cover Groups section below 

22 Season                          “Spring”, “Summer”, “Fall”, “Winter” 

23 Fuel Category                “Natural”, “Piles”, “Slash” 

244 Soil Family               “Loamy-Skeletal”, “Fine-Silt”, “Fine”, “Coarse-Silt”, 
“Coarse-Loamy” Use  “NA” to indicate none 
available, in which case no soil heating will be 
calculated for the record 

254 Soil Moisture          Soil Moisture; range 0 – 25% 
1 1000 hour fuels can be entered as a total or as individual size class amounts. See Entering 
Individual Size Classes 

 



FOFEM 6.3 User Guide 

37 
 

2 Size class distributions. 

Size Class 3 – 6 in. 6 – 9 in. 9 – 20 in. 20+ in. 

Even 25% 25% 25% 25% 

Right 7% 16% 27% 50% 

Left 50% 27% 16% 7% 

End 35% 15% 15% 35% 

Center 15% 35% 35% 15% 
 

3 If you do not have duff fuel, enter zeros for load and depth, a minimum moisture amount of 
10 and “Entire” for Duff Moisture Method. Even when there is no duff fuel the Burnup 
model still requires duff moisture to work.  

4 Input files running the Soil Model Type require fields 24 & 25. 

5Moisture Regime defaults are based on western systems: 

Regime Duff 10-hr 3+ in Soil 

Wet 130 22 40 25 

Moderate 75 16 30 15 

Dry 40 10 15 10 

Very Dry 20 6 10 5 

 

Setting Cover Groups  

FOFEM batch was designed to accommodate a wide variety of users and their data (with/without cover 
type and various cover type classifications). Accordingly it has been setup to use a cover group code 
rather than what would be a rather extensive list of cover types from multiple cover type classifications.  

Cover Group is used to determine appropriate consumption formulas for herbaceous, shrub and duff 
fuel loading, in turn fuel consumption is used to compute smoke emission amounts and simulate soil 
heating.    

Type Short code Long code 

Grass GG GrassGroup 

Shrub SG   ShrubGroup 

Sagebrush SB   Sagebrush 

Ponderosa pine PN Ponderosa 

Pocosin PC Pocosin 

Balsam, Black, Red, White Spruce BBS BalBRWSpr 

Red, Jack Pine RJP RedJacPin 

White Pine Hemlock WPH WhiPinHem 

 
If you cannot determine a Cover Group use the double quote marks (“”) to indicate none and 
consumption will be calculated using the general consumption algorithm.  



FOFEM 6.3 User Guide 

38 
 

NOTE: For more details concerning how cover groups are used to determine consumption see 
Cover Groups, Decision Dependency, Duff Consumption, Herbaceous Consumption and Shrub 
Consumption 

Switches 

The Consumed Emissions and Consumed Emission Soil batch input files have three optional switches:  

#Emission-File EmFile: This switch creates an emission file for each plot. The required switch argument 
(‘EmFile’) will be used as the prefix for the emissions output files. The files are saved in the same 
folder as the other output files and will have .emi extensions.  

#BurnUpFile Burnup.txt: This switch specifies the name of the Burnup parameter file. Do not specify a 
path. Place the parameter file in the same folder as the input file. 

#1k-SizeClass: This switch specifies down woody fuels greater than 3 inches in diameter (1000-hour 
fuels) are entered in size classes.  Replace columns 7 thru 10 described in Batch File Description table 
with the nine columns in the table below. Then enter Duff in column 16 followed by the remaining 
data described in the Batch File Description table (i.e., duff, duff moisture, duff depth…). 

 

Column 

No. 

Description 

7 3 – 5.9 in. sound (T/ac) 

8 6 – 8.9 in. sound (T/ac) 

9 9 – 19.9 in. sound (T/ac) 

10 20 + in. sound (T/ac) 

11 3 – 5.9 in. rotten (T/ac) 

12 6 – 8.9 in. rotten (T/ac) 

13 9 – 19.9 in. s rotten (T/ac) 

14 20 + in. rotten (T/ac) 

15 1000 Hour fuel moisture (%) 

 

Batch Output File - Consumed Emission Soil  

Each fuel component shows post and consumed amounts in tons per acre. 

Emissions are shown for Flaming and Smoldering in pounds per acre. 

Column No. Field name Description 

1 Std                     Stand/plot Id from input file 

 LitPre Pre fire loading (T/ac) 

2 LitCon Consumed loading (T/ac) 

3 LittPos Post fire loading (T/ac) 

 DW1Pre Pre fire 1-hour loading (T/ac) 

4 DW1Con Consumed 1-hour loading (T/ac) 

5 DW1Post Post fire 1-hour loading (T/ac) 

 DW10Pre Pre fire 10-hour loading (T/ac) 

6 DW10Con Consumed 10-hour loading (T/ac) 

7 DW10Post Post fire 10-hour loading (T/ac) 
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 DW100Pre Pre fire 100-hour loading (T/ac) 

8 DW100Con Consumed 100-hour loading (T/ac) 

9 DW100Post Post fire loading (T/ac) 

 DW1kSndPre Pre fire 1000 hour sound loading (T/ac)  

10 DW1kSndCon Consumed 1000 hour sound loading (T/ac) 

11 DW1kSndPost Post fire 1000 hour sound loading (T/ac) 

 DW1kRotPre Pre fire 1000 hour rotten loading (T/ac) 

12 DW1kRotCon Consumed 1000 hour rotten loading (T/ac) 

13 DW1kRotPost Post fire 1000 hour rotten loading (T/ac) 

 DufPre Pre fire duff loading (T/ac) 

14 DufCon  Consumed duff loading (T/ac) 

15 DufPos Post fire duff loading (T/ac) 

 HerPre Pre fire herb loading (T/ac) 

16 HerCon Consumed herb loading (T/ac) 

17 HerPost Post fire herb loading (T/ac) 

 ShrPre Pre fire shrub loading (T/ac) 

18 ShrCon Consumed shrub loading (T/ac) 

19 ShrPost Post fire shrub loading (T/ac) 

 FolPre Pre fire crown foliage loading (T/ac) 

20 FolCon Consumed crown foliage loading (T/ac) 

21 FolPost Post fire crown foliage loading (T/ac) 

 BraPre Pre fire crown branch loading (T/ac) 

22 BraCon Consumed crown branch loading (T/ac) 

23 BraPost Post fire crown branch loading  (T/ac) 

24 MSEPer Post fire mineral soil exposed (%) 

 DufDepPre Pre fire duff depth (in.) 

25 DufDepCon Consumed duff depth (in.) 

26 DufDepPost Post fire duff depth (in.) 

27 PM10F PM10 flaming emissions (lb/ac) 

28 PM10S PM10 smoldering emissions (lb/ac) 

29 PM25F PM2.5 flaming emissions (lb/ac) 

30 PM25S PM2.5 smoldering emissions (lb/ac) 

31 CH4F CH4 flaming emissions (lb/ac) 

32 CH4S CH4 smoldering emissions (lb/ac) 

33 COF CO flaming emissions (lb/ac) 

34 COS CO smoldering emissions (lb/ac) 

35 CO2F CO2 flaming emissions (lb/ac) 

36 CO2S CO2 smoldering emissions (lb/ac) 

37 NOXF NOx flaming emissions (lb/ac) 

38 NOXS NOx smoldering emissions (lb/ac) 

39 SO2F SO2 flaming emissions (lb/ac) 

40 SO2S SO2 smoldering emissions (lb/ac) 

41 FlaDur  Total flame time (seconds) 

42 SmoDur Total smoldering time (seconds) 

43 FlaCon Total flame consumed amount  (T/ac) 

44 SmoCon Total flame consumed amount  (T/ac) 
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451 Lay0 Layer 0 maximum temperature at soil surface (C) 

461 Lay2 Layer 2 maximum temperature at 2 cm (C) 

471 Lay4 Layer 4 maximum temperature at 4 cm(C) 

481 Lay6 Layer 6 maximum temperature  at 6 cm (C) 

491 Lay60d Deepest layer reaching 60 degrees C  (cm) 
“-1” means no layer reached that temperature  

501 Lay275d Deepest layer reaching 275 degrees C (cm) 
“-1” means no layer reached that temperature  

   1 When Model Type = Consumed-Emissions-Soil these additional columns of output will be added. 

Batch - Tree Mortality 

Batch Input File – Tree Mortality 

Input files use a comma delimited format. Numerical fields can be entered as integer or floating point 
numbers. Text fields must be contained in double quote marks (e.g., “PINPON”, “Low”).  Comment lines 
can be inserted by placing a “#” in column 1, blank lines are also allowed.  

Any input records containing errors will not be included in mortality predictions for the stand.  If an 
unusual large number of error messages occur while you are processing a file you should check the input 
file format and also make sure that you have selected the proper Model Type for the input file you are 
using.  

There is an option on the Batch dialog box for creating sample batch input files. The sample files contain 
comments and column headings to aid you in formatting your own files.  

 

Mortality Batch File Description table 

Column No. Field Name                 Description 

1 Stand Id      Text or numeric. This field can be entered with or without 
delimiting double quote marks. Do not use embedded blank 
characters, for example use "Ridge-1" instead of “Ridge 1”  

2 Tree Species         NRCS tree species code. See the fof_spp.dat file for a 
complete list of valid codes. The file can be found in the 
FOFEM install directory, be careful not alter file in any way. 
Enclose in double quotes. 

3 Stand Density        Trees per acre 

4 DBH Diameter Breast Height (in.) 

5 Tree Height            Tree Height (ft) 

6 Crown Ratio           Crown Ratio; range 1 - 10 

7 Flame Length  
or Scorch 
Height      

You can enter a flame length or a scorch height  (ft) 

8 Col 7 
Identifier        

Text. Enter “F” to specify you are using Flame Length in 
Column 7 or “S” for scorch height. 
 

9 Fire Severity           Text, "Low" for low or leave blank "" 
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Batch Output File – Mortality 

One output record is created for each stand. 

Column No. Field Name                 Description 

1 Std Stand/plot Id from input file 

2 DenPre Total number of pre-fire trees (trees/acre) 

3 DenPost Total number of post fire trees (trees/acre) 

4 DenKld Total number of trees killed (trees/acre) 

5 BAPre Total basal area of pre-fire trees (ft2) 

6 BAPost Total basal area post fire (ft2) 

7 BAKld Total basal area of the killed trees (ft2) 

8 CCPre Total crown cover of pre-fire trees (%) 

9 CCPost Total crown cover of post fire trees (%) 

10 CCDiff Total crown cover change (%) 

11 DBHKldAvg Arithmetic mean DBH of killed trees (in.) 

12 MortAvgPct4 Average percent mortality for trees where DBH >4 inches (%) 

13 MortAvgPct Average percent morality for all trees (%) 

 

NOTE:  Batch processing is currently not available for the post-fire injury tree mortality option.   

Batch Burnup Parameter File 

This file allows you to set specific input parameters for the Burnup model that FOFEM uses to simulate 
fuel consumption.  The parameters in this file will be used instead of the default parameters used in 
FOFEM. See the example file below.  

To use a Batch Burnup Parameter File you place the #Burnup File switch and file name at the top of a 
batch input file. The following sample file can be used as is.  

NOTE: In FOFEM batch input files lines that are comments begin with a “#” followed by a space 
and then the comment text. Lines that are switches begin “#”, followed immediately by the name 
of the switch. For example: # FOFEM example file is a comment. #MAX_TIMES is a switch.   

 

Example Batch Parameter File 

 
# Sample Burnup input Parameter File 

# This file is used in conjunction with the Batch input 

# file command switch #BurnUpFile  

# 

# maximum number iterations burnup does, default 3000 

# valid 1 -> 100000 

#MAX_TIMES 3 

# intensity of the igniting surface fire, 

# kW/m2 sq m, 40.0 -> 1.0e5, burnup var - fi  default 50.0 

#INTENSITY 0.0 

# residence time of the ignition surface fire, seconds 

# default = 60.0, fofem's burnup input file uses 30.0 

# burnup var = ti,   limits 10.0 -> 200.0 

#IG_TIME 60 

# windspeed at top of fuelbed meters/second 

# burnup var = u, default 0, limits 0.0 -> 5.0, 

#WINDSPEED 0.0 



FOFEM 6.3 User Guide 

42 
 

# fuel depth, meters, 

# burnup var = d, defualt 0.3, limits 0.1 -> 5.0 

#DEPTH  0.3 

# ambient air temperature, degrees Celsius 

# burnup var = tamb, default 27, 

# if ( tamb-273 < tam1 || tamb-273 > tam2) 

# const double tam1 = -40.0,  tam2 = 40.0; 

#AMBIENT_TEMP  27.0 

# fire environment minumum dimension paramter 

# default 1.83 

#R0  1.83 

# fire environment increment temp parater 

# default 0.40 

#DR  0.4 

# time step for integration of burning rates. 

# TIMESTEP * MAX_TIMES gives max simulation period default 15 

#TIMESTEP 15 

# Sigma - Surface area to volume ratio 

#SURat_Lit          8200.0 

#SURat_DW1          1480.0 

#SURat_DW10          394.0 

#SURat_DW100         105.0 

#SURat_DWk_3_6        39.4 

#SURat_DWk_6_9        21.9 

#SURat_DWk_9_20       12.7 

#SURat_DWk_20         5.91 

Scientific Content – Soil Heating 

The soil heating component is a product of many years of work by several different researchers. This 
model is intended to give a view of soil heating based on point-based surface fuel and soil conditions. 
However, fire practitioners and researchers understand that fire is non-uniform and often erratic in 
behavior.  As a consequence of this variability, it is difficult to attempt to predict soil heating on a unit 
scale when in reality most fire patterns are mosaic.  We strongly encourage the user to experiment with 
a variety of model input values in order to best predict and understand varying fire regimes. For 
example, run a number of simulations of various sampled fuelbeds and assume the simulated effects are 
distributed spatially with the same frequency as the distribution of the fuelbeds. 

The degree and depth of mineral soil heating over time is simulated using a model developed at the 
Rocky Mountain Research Station Fire Sciences Laboratory in a joint effort with Dr. Gaylon S. Campbell 
and staff at Washington State University. This model assumes that soil temperature gradients in the 
horizontal direction are small compared to those in the vertical direction and the model predicts the 
downward heat flow into the soil using a one-dimensional model. This model has broad applicability due 
to its ability to predict soil temperature depth profiles over a wide range of soil moistures, densities and 
mineralogy. 

Before the Campbell soil heating model is initiated the FOFEM model uses two alternative approaches 
to simulate the amount of heat delivered to the soil surface. The non-duff model assumes radiant 
heating (simulated in the Burnup model) from the flaming combustion of the woody, litter, herbaceous 
and shrub fuelbed components heats the soil surface. Alternatively, the duff model assumes radiant and 
conductive heat from only the burning duff/organic soil horizons heats the soil surface.  

The energy at the soil surface resulting from surface fires (non-duff model) is often of moderate to high 
intensity but of short duration. In contrast to flaming combustion, smoldering (duff model) is commonly 
characterized by lower energy intensities and longer durations. After ignition, the continued smoldering 
of the duff/organic soil horizons is no longer dependent on the surface fire environment but is a 
function of soil moisture, mineral content and bulk density. Total heat at the soil surface is often greater 
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than resulting from surface fires because of the long duration and relatively close proximity of the 
smoldering combustion front and the mineral soil surface (Neary et al, 2005). 

In FOFEM, the transfer of heat from the surface into and within the mineral soil is accomplished using 
the 1-dimensional Campbell model and is a function of soil moisture and soil properties.  The soil 
heating model is more sensitive to the amount and the duration of heat released during burning and the 
soil moisture content and is less sensitive to other characteristics such as soil family type or texture. 

The soil heating component of FOFEM has been designed in a way that makes it easy for the user to 
change key variables like duff depth, moisture content, and soil family directly on the user interface. 
There is also an option for the user to run the soil heating model from input files changing more specific 
inputs to the soil heating model.  

Assumptions for the duff soil heating model 

The duff model simulates soil heating resulting from the transfer of heat from the duff smoldering 
combustion zone into the mineral soil.  The total energy reaching the mineral soil surface is a function of 
the heat energy content of the duff soil material, moisture content and the duration of smoldering and 
is the product of duff consumed (kg m-2) and the energy content of duff fuels). Duff consumption is 
calculated using the appropriate duff consumption equation based on the selected region, 
fuel/vegetation type and duff moisture. Duff moisture can be directly input or the user may choose one 
of the fuel moisture regimes from the FOFEM interface (very dry to wet). 

FOFEM uses total duff load consumed and duff moisture in the logic provided by Albini (1994) to 
determine the intensity of consuming duff at each time step assuming heat from burning peat = 20 
MJ/kg (Frandsen 1987):  

 Id = (7.5x10-4) – (2.7x10-4RM);   

where Id is the intensity of the burning duff (kg s-1 m-2) and  RM is the gravimetric soil moisture (Frandsen 
1991b).  In FOFEM, duff burning rate is not influenced by wind or burning surface fuels. 

It is commonly observed that not all heat from smoldering is directed downward into the soil. The 
amount of heat from smoldering transferred to the soil is dependent on a several factors. During 
smoldering the remaining unburned duff between the combustion zone and the soil surface acts as an 
efficient insulator. The proportion of heat directed to the soil surface is calculated with the equation: 

H = 1.6996 + (32.7652 * EXP(-7.4601*Dd)) + (68.9349 * EXP(-0.6077*Dd)) 

Where H is the percent of total heat of combustion that is directed to the soil surface, Dd is duff depth 
measured in cm.  This equation does not account for soil moisture which is a variable that may 
significantly influence the conductivity of heat in duff. 
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Duff smoldering is commonly observed many hours after flaming combustion has ended.  The long 
duration of smoldering is a major factoring influencing heat transfer into the soil and subsequent fire 
effects. FOFEM predicts the duration of smoldering as a function of duff thickness, moisture and mineral 
content (Frandsen 1991).  

Assumptions for non-duff soil heating model 

When no duff/ or organic soil horizon is present then soil heating is driven by the radiant energy from 
flaming combustion of litter, woody fuels, herbs and shrubs. Burning duration of litter and woody fuels 
is determined in Burnup.  Herb and shrub fuels burn at a rate of 10 t ac-1 min-1. The non-duff model 
assumes only a portion of the consumption intensity is delivered to the soil surface. These values were 
developed after comparing simulated outputs to results from field data.  

Component Proportion of intensity 

directed to soil surface 

Woody debris and litter 15% 

Herbaceous and shrubs 10% 

Running Soil Heating from Main Menu  

The soil heating component of FOFEM gives the option to run the Duff or Non-Duff model from a soil 
heating input file.  

From the main FOFEM menu: 

 Options > Create Sample Soil Input File. This selection creates a soil heating input file for the “duff” 
or the “non-duff” input files. 

 Options > Run Soil from an Input File.  This selection will run an existing soil heat input file. The 
input file extensions are; .exp and .duf for the non-duff and duff models, respectively 



FOFEM 6.3 User Guide 

45 
 

The simplest method to produce an input file is to use the Create Sample Soil Input File (.exp, .duf) 
option from the menu. Some input values in the data files result from the user selections on the FOFEM 
GUI interface. This file can then be edited to make the desired changes.     

Duff Model Input File Input File Description 

Section 1 
This section may be used to document user changes to the input file. 

 # - The line starting with a pound sign (#) followed by a space is a comment. You can enter an entire 
line(s) as a comment as long as you start it with a pound sign in column one.  

Section 2 
This section defines the duff fuel parameters.  

 Duff weight (Tons/Acre) is the preburn duff loading. Default values are used for the selected fuel 
types or the user may enter other values.  

 Duff depth (inches) is the duff layer thickness. Default values are used for the selected fuel types 
of the user can enter other values.  

 Duff consumed (%) is the percent duff consumed 0 -100% (integer values). Consumption is 
estimated from the default fuel type duff consumption equation or the user may enter other values.  

 Duff moisture content (%) is the gravimetric moisture content (%) and is typically obtained by 
oven drying. Moisture values vary from 10 % or less for extremely dry conditions to 75 to 130 % for wet 
conditions.  Values of 10% or less will result in 100% duff consumption for all fuel types.  

Section 3  
This section defines the various soil properties. Soil bulk density, soil particle density and thermal 
conductivity are determined from the soil family type (Table 3). Two parameters of most immediate 
interest to users are: 

 Soil starting water content (g/cm3) - is the volumetric soil moisture content.  It can be estimated as 
function of  bulk density ( g/cm^3) and the mass of water (g) 

 Soil starting temperature (C0)- The temperature of mineral soil at the start of the soil heating 
simulation is assumed to be uniform  throughout the depth profile used for predictions. 

Other parameters in this section have been determined by laboratory work. These default values for 
each soil family type should not be modified.  

Section 4  
This section of the input file begins with the word ‘layers’ on a single line starting column 1.  

Each of the values on this line represents a depth (centimeters) that the model will predict 
temperature at. Note: the user must specify 13 depths. 
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Example Duff soil input file 

Section 1 
# Duff Model - Example Inputs File  

# Use this file type when duff is present  

# Lines that start with a # are comments.  

# Warning: extreme or missing values in this file can  

# cause unexpected results.  

# These inputs represent the current GUI settings.  

# However if no duff is present a fictitious amount will be used. 

# And the soil type = Coarse-Silt  

Section 2 
Duff-Model           

duff-weight             5.0   pre-burn weight - (T/ac)  

duff-depth             0.50   duff depth - (in)  

duff-consumed          66.7   percent consumed, whole integer 0 -> 100  

duff-moisture          40.0   very dry 20, dry 40, moderate 75, wet 130  

Section 3 
bulk-density           1230000   soil bulk density - (g/m3)  

particle-density       2350000   soil particle density - (g/m3)  

extrap-water           0.16   extrapolated water cont. at -1 (J/kg)  

thermal-conduct        2.53   thermal conductivity of mineral fraction 

Vries-shape            0.103   de Vries shape factor 

water-content          0.218   water content for liquid recirculation 

cop-power              3.43   power for recirculation function 

time-step              10      time step - (sec)  

start-water            0.10   starting soil water content, Wet 0.25, Mod 0.15, Dry 10, V-

Dry 5,  m3/m3 

start-temp             21.0   starting soil temperature (C)  

Section 4 
# Specifiy exactly 13 depths (cm) 

layers   1 2 3 4 5 6 7 8 9 10 11 12 13 

Non-Duff Model Input File Description 

Section 1 
This section can be used to document changes to the input file.   

 # - The line starting with a pound sign (#) followed by a space is a comment. You can enter an entire 
line(s) as a comment as long as you start it with a pound sign in column one.  

Section 2 
This section defines the various soil properties. Soil bulk density, soil particle density and thermal 
conductivity are determined from the soil family type.  In this section, two parameters of interest to 
most users are: 

 Soil starting water content (g/cm3) - is volumetric mineral soil moisture. It can be estimated as 
function of bulk density (g/cm^3) and the mass of water (g).  It is assumed to be uniform throughout 
the soil depths at the beginning of the heating simulation. 

 Soil starting temperature (C0) - The mineral soil is assumed to be at a uniform temperature 
throughout the depth profile used for temperature predictions. 

Other parameters in this section have been determined by laboratory work and at this time the default 
values for each soil family type should be used. (See tables 1 -3 for soil parameters) 
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Section 3 
This section of the input file begins with the word ‘layers’ on a single line starting column 1.  

Each of the values on this line represents a depth (centimeters) that the model will predict temperature 
at. Note: the user must specify 13 depths. 

Section 4 
This section defines the proportion of radiant energy generated by flaming combustion of the surface 
fuels that is transferred to the soil.   

 Efficiency WL and Efficiency HS (%) - The user can define the percent of heat transferred downward 
into the bare soil by the Wood/Litter and Herb/shrub loads. In general, estimates of the energy 
reaching the soil surface from flaming combustion range from 5 to 25 %.   

 FI- interval (sec) - The user may modify the duration of surface heating by changing the ‘fi-interval’ 
value.   

Section 5 

 Fire intensity (kW/m^2) - Values in the two columns of this section are fire intensity estimates.  The 
estimates are calculated in FOFEM from the Wood/Litter and Herb/Shrub loadings of the selected 
fuel type. These estimates are modified by the WL and HS efficiency values before they are input 
into the model.    

 

Example Non-duff soil input file  

Section 1 
# Non-Duff Model - Example Input File  

# Use this file type when there is an absence of duff 

# Lines that start with a # are comments.  

# Warning: extreme or missing values in this file can  

# cause unexpected results.  

# These inputs represent the current GUI settings. 

# However the fire intensity values below may not be 

# totally accurate if there is duff present on the plot 

# Values represent soil type = Coarse-Silt  

Section 2 
NonDuff-Model   

bulk-density           1230000   soil bulk density - (g/m3)  

particle-density       2350000   soil particle density - (g/m3)  

extrap-water           0.16   extrapolated water cont. at -1 (J/kg)  

thermal-conduct        2.53   thermal conductivity of mineral fraction 

Vries-shape            0.103   de Vries shape factor 

water-content          0.218   water content for liquid recirculation 

cop-power              3.43   power for recirculation function 

time-step              10      time step - (sec)  

start-water            0.10   starting soil water content, Wet 0.25, Mod 0.15, Dry 0.10, V-Dry 

0.05,  m3/m3 

start-temp             21.0   starting soil temperature (C)  

Section 3 
# Specifiy exactly 13 depths - (cm) 

layers   1  2  3 4  5  6  7  8  9  10  11  12  13 

 

# Specify fire intensity (Kw/m2) for Wood/Liter and Herb/Shrub 

efficiency-WL    15    percent of Wood and Liter fire intensity applied to soil surface  

efficiency-HS    10    percent of Herbaceous and Shrub fire intensity applied 

to soil surface 
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fi-interval       15    time between fire intensity values listed in arrays 

below - (sec)  

Section 4 
# Fire intensity (kW/m2) arrays for Wood/Liter and Herb/Shurb  

# specify total fire intensity (above efficiency percents will be applied to these values)  

# values must start on the line immediately after 'fire-intensity'  

fire-intensity  

    22     10  

    43     21  

    65     31  

    86     42  

    35      0  

    26      0  

    23      0  

    21      0  

    19      0  

    18      0  

    17      0  

    17      0  

    16      0  

    15      0  

    14      0  

Soil Family Description  

 Loamy-Skeletal: Rock fragments make up 35% or more by volume; enough fine earth to fill 
interstices larger than 1 mm; the fraction finer than 2 mm is loamy as defined for the loamy particle-
size class.  

 Fine-Silty: By weight, <15% of the particles are fine sand (diameter 0.25-0.1 mm) or coarser, 
including fragments up to 7.5 cm in diameter; 18 – 34% clay in the fine-earth fraction.  

 Fine: A clayey particle-size class that has 35 – 59% clay in the fine-earth fraction. 

 Coarse-Silty: By weight, <15% of the particles are fine sand (diameter 0.25-0.1 mm) or coarser, 
including fragments up to 7.5 cm in diameter; <18% clay in the fine-earth fraction.  

 Coarse-Loamy: By weight, 15% or more of the particles are fine sand (diameter 0.25-0.1 mm) or 
coarser, including fragments up to 7.5 cm in diameter; <18% clay in the fine-earth fraction. 

 

Descriptions of soil types used in the development of the soil heating model (Campbell, et al. 1995) 

Soil Name Soil Family Type Soil Class Location 

Quincy sand Sand Mixed mesic Xeric Torripsamment Hanford, WA 

Boldercreek  Loamy-skeletal Mixed frigid Typic vitrandept Wallace, ID 

Palouse B Fine-silty Mixed mesic  Pachic Ultic Haploxeroll Whitman Co. WA 

Volkmar Silt loam Aeric Cryaquept Delta, AK 
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Soil Simulation Outputs  

The results of each soil heating simulation can be output in either graphical or report form.  

 

Soil Heating Graph 

The graphical format plots temperature in Celsius (C) verses time in minutes and allows for scaling 
adjustments along the x and y-axis. The graph displays temperature at each depth and highlights 
temperatures that exceed 60 degrees C; this temperature is typically considered the lethal tissue 
temperature for living organisms. The graphical output also includes the starting soil moisture, soil type, 
post fire duff depth and maximum temperature reached at the soil surface.  Intensity is shown in the 
bottom graph. Right-click either graph to save or print the image. 
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Soil Heating Report 

Users can also view the output of each soil heating simulation in report form. This option is useful for 
comparing different soil heating scenarios using the Summary Report functionality.  

 

                            

Output Graphing File  

FOFEM can create an output text file that can be used as input for other graphing programs, for example 
Excel or SPSS. To save the soil points to a file select Options > Save Soil Temp Points File.  

Below is a small part of an output file. The grid of values that represents the current graph displayed in 
the FOFEM graph window. Accordingly you must create a soil graph before you attempt to save the 
points to a file.  

 

 

Time Surface Layer 1 Layer 3 Layer 4 Layer 5 Layer 6 Layer 7 Layer 8 Layer 9 

min. cm 

0.3 31.4 21.6 21.0 21.0 21.0 21.0 21.0 21.0 21.0 

0.7 34.3 22.3 21.0 21.0 21.0 21.0 21.0 21.0 21.0 

1.0 36.4 23.0 21.0 21.0 21.0 21.0 21.0 21.0 21.0 

1.3 37.9 23.9 21.0 21.0 21.0 21.0 21.0 21.0 21.0 

… … … … … … … … … … 

 

Column 1 is decimal minutes since ignition, column 2 is the temperature (C) of surface layer at the 
specified time, column 3 is the temperate at 1 cm depth and subsequent columns show soil 
temperature at the specified depth.  The temperature of 21oC represents the ambient temperature that 
is used in this example.  

Soil Heating Citations and Sources  

Albini, F.A. 1994. Program Burnup: A simulation model of the burning of large woody natural fuels. 
Unpublished report on file at the Missoula Fire Sciences Lab. 

Campbell, G.S. Simulation of soil heating under smoldering duff fires. Unpublished report on file at the 
Missoula Fire Sciences Lab.  

Soil Heat Report 

 

 Region:         InteriorWest 

 Cover Type:     SAF 016 - Aspen 

 Fuel Type:      Natural  

 Fuel Reference: FOFEM 561  

 Duff Depth.....: Pre-Fire:   1.27 cm.,  Post-Fire:   0.42 cm. 

 

                        Soil Layer Maximum Temperature 

 

Depth (cm)    0    1    2    3    4    5    6    7    8    9   10   11   12   13 

Temp (C)    163   66   51   40   34   30   28   27   25   24   23   22   21   21  

Time (min)   19   19   20   27   37   51   66   83   97  107  115  120  123    0 

 

Max Depth Having 60 degrees: 1 

Max Depth Having 275 degrees: - None - 
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Campbell, G.S., J.D. Jungbauer, Jr., S. Shiozawa, and R.D. Hungerford. 1993. A one-parameter equation 
for water sorption isotherms of soils. Soil Science 156(5): 302-305.  

Campbell, G.S., J.D. Jungbauer, Jr., W.R. Bidlake, and R.D. Hungerford. 1994. Predicting the effect of 
temperature on soil thermal conductivity. Soil Science 158(5): 307-313.  

Campbell, G.S., J.D. Jungbauer, Jr., K.L. Bristow, and R.D. Hungerford. 1995. Soil temperature and water 
content beneath a surface fire. Soil Science 159(6): 363-374.  

Fransden, W.H. 1987. The Influence of Moisture and Mineral Soil on the Combustion Limits Of 
Smoldering Duff. Can. J. For. Res. 17: 1540-1544. 

Frandsen, W.H. 1991. Heat Evolved From Smoldering Peat. Int. J. Wildland Fire 1(3): 197-204. 

Frandsen, W.H. 1991. Burning Rate of Smoldering Peat. 1991. Northwest Science.  Vol. 65, No. 4. pp 166-
172.  

Hungerford, R.D., M.G. Harrington, W.H. Frandsen, K.C. Ryan, and G.J. Niehoff. 1991. Influence of fire on 
factors that affect soil productivity. U.S. Forest Service Intermountain Research Station General 
Technical Report INT-280. 

Nary, Daniel G.; Ryan, Kevin C.; DeBano, Leonard F., eds. 2005. (revised 2008). Wildland fire in 
ecosystems: effects of fire on soils and water. Gen. Tech. Rep. RMRS-GTR-42-vol.4. Ogden, UT: U.S. 
Department of Agriculture, Forest Service, Rocky Mountain Research Station. 250 p. 

Scientific Content - Computing Bark Thickness 

The longleaf pine the bark thickness equation comes from:  Wang, GG; Wangen, S;  Reinhardt, E; 
Waldrop, TA, Outcalt, KW; Walker, JL; Brockway, DG; Haywood, JD; Hiers, JK. 2007. Modify FOFEM for 
use in the Coastal Plain Region of the Southeastern US. JFSP Program Report: 05-4-3-06. Available at: 
http://www.firescience.gov/projects/05-4-3-06/project/05-4-3-06_final_report.pdf 

Longleaf SBT = 0.435 + ( 0.031 * DBH) 

Where SBT is single bark thickness (cm) and DBH is diameter breast height (cm). 

The remaining FOFEM bark thickness equations are from the equations and sources listed in the Forest 
Vegetation Simulator with modifications made using descriptions in: North American Trees by R.J. 
Preston, Jr.; A Natural History of Western Trees and A Natural History of Trees of Eastern and Central 
North America by D. C. Peattie and The Audubon Society Field Guide to North American Trees, Western 
and Eastern regions by E. L. Little. In the FOFEM model, spruce spp. mortality is constricted by factors 
other than bark thickness to be at least 80 percent, thus the FOFEM bark thickness equations for the 
spruces are the least researched.  

Single bark thickness (SBT) is assumed to have a linear relationship to diameter breast height (DBH), 
both measured in inches, in the form SBT=v(DBH); where v is a species specific bark thickness coefficient 
from table 1. Species specific bark thickness indices can be found in the “Brk” column of the 
FOF_SPP.DAT file typically located in C:\Users\username\AppData\Local\FOFEM. 
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Table 1. FOFEM bark thickness indices and coefficients.  
 
 
 

 

 

 

 

 

 

 

 

 

Scientific Content - Computing Tree Mortality 

Estimating Tree Mortality - “Pre-fire” 

Tree mortality in FOFEM is computed using the algorithm developed by Ryan and Reinhardt (1988) for 
the majority of the species. It uses bark thickness and percent crown volume scorched as predictive 
variables.  This method implicitly assumes that variations in fire caused tree mortality in trees of 
different species and sizes can be accounted for primarily by differences in bark thickness and 
proportion of crown killed.  This assumption, while undoubtedly extremely simplistic, allows us to 
predict mortality for any trees as long as we can estimate bark thickness, tree height, crown ratio and 
scorch height.  

New mortality equations for many western conifer species were developed for FOFEM 5.x and offer 
improvement over the Ryan and Reinhardt algorithm. See Hood et al. (2007) for an evaluation of the 
Ryan and Reinhardt algorithm. These species and models are listed below. These models all predict tree 
mortality occurring within 3 years of the fire. 

Either scorch height or flame length may be used in FOFEM to predict tree mortality.  If flame length is 
entered, scorch height is computed using Van Wagner’s (1973) scorch height model, assuming a 
temperature of 77 degrees F and a midflame wind speed of 0 mph.  These values seem conservative for 
many situations since computed scorch height varies little with temperature between 40 and 80 degrees 
F, and wind speeds between 0 and 10 mph. These ranges encompass many prescribed fire situations. At 

Bark thickness 
index 
FOF_SPP.DAT 

Bark thickness 
coefficient 

Bark thickness 
index FOF_SPP. 
DAT 

Bark thickness 
coefficient 

1 0.019 21 0.042 

2 0.022 22 0.043 

3 0.024 23 0.044 

4 0.025 24 0.045 

5 0.026 25 0.046 

6 0.027 26 0.047 

7 0.028 27 0.048 

8 0.029 28 0.049 

9 0.03 29 0.05 

10 0.031 30 0.052 

11 0.032 31 0.055 

12 0.033 32 0.057 

13 0.034 33 0.059 

14 0.035 34 0.06 

15 0.036 35 0.062 

16 0.037 36 0.063 

17 0.038 37 0.068 

18 0.039 38 0.072 

19 0.04 39 0.081 

20 0.041   
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higher wind speeds typical of many wildfires, computed scorch heights actually decrease for a given 
flame length, so predicted scorch height and consequently, tree mortality will be over predicted. 
Entering scorch height directly allows the user to bypass these assumptions, if they are of concern. Van 
Wagner’s scorch height model was developed from stands of red pine on flat ground; it can be expected 
to perform poorly on steep slopes, at ridge tops, and in stands with large openings in the canopy. Again, 
using scorch height as a predictive variable, instead of flame length, allows the user to avoid errors in 
predicting scorch height. This may be an especially good option when predicting effects of fire after the 
fact – in this case scorch height can be observed directly in the field.  

In predicting stand mortality, FOFEM assumes a continuous fire.  If a burn is very discontinuous or 
patchy, and the user can estimate the proportion of the area burned, then the per acre estimates of tree 
mortality computed by FOFEM can be adjusted by multiplying them by the proportion burned. 

The data from which the tree mortality algorithm was developed was limited to western conifers greater 
than 5 inches DBH under burned with prescribed fire. The predictions should apply reasonably well to 
wildfires. Some post fire insect damage is implicitly included in these predictions, as trees damaged by 
insects after burning were not excluded from the data.  Major post fire insect attacks are not modeled 
however.  Root damage is not explicitly modeled, although it may be correlated with cambial damage in 
many cases.   

The mean, standard error, median, and range of crown scorch and DBH by species of trees used to 
develop pre-fire mortality models are listed below. Species are listed in order of increasing bark 
thickness using bark thickness equations in FFE-FVS. 

 

Species 
No. of 
trees 

Type1 
Crown Scorch % DBH (cm) 

Mean +SE Md Range Mean +SE Md Range 

Lodgepole pine 2196 V 19 ± 0.7 0 0-100 20.8 ± 0.1 19.6 10.2-56.4 

Whitebark pine 148 V 24 ± 2.9 2 0-100 22.9 ± 0.6 22.5 12.4-58.9 

Engelmann spruce 223 V 30 ± 2.2 20 0-100 33.2 ± 1.1 30.2 12.7-85.1 

Red fir 209 L 42 ± 1.8 46 0-89 42.1 ± 1.2 38.9 15.2-104.6 

Subalpine fir 947 V 65 ± 1.3 85 0-100 19.4 ± 0.2 17.5 10.2-75.2 

White fir 2304 L 67 ± 0.5 74 0-100 59.2 ± 0.4 56.9 15.2-152.7 

Incense cedar 783 L 40 ± 1.1 38 0-98 51.6 ± 0.9 43.7 25.4-166.4 

Yellow pine2 7309 V 58 ± 0.4 70 0-100 41.8 ± 0.3 35.1 6.3-178.1 

Douglas-fir 1539 V 34 ± 0.9 20 0-100 33.7 ± 0.4 30.5 10.2-105.4 

Western larch 461 V 26 ± 1.7 5 0-100 38.1 ± 0.6 38.1 10.2-98.8 

Sugar pine 719 L 40 ± 1.1 41 0-98 73.3 ± 1.0 70.4 25.6-188.0 
1 L = crown length; V = crown volume 
2 Includes ponderosa and Jeffrey pine         
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Mortality Equations – “Pre-fire” 

_____________________________________________________ 
Equation 1:  
Used when other equations are not specified. Pm = probability of mortality, BT=bark thickness (in.), 
CS= crown volume scorched (%) 

If DBH> 1” then  ))](*000535.0)))exp(0.1(*316.6(941.1exp(1/1 2CSBTPm   

If DBH < 1” and Crown Height/Length Scorched > 50% then Pm = 1 
If DBH < 1” and Ht < 3’ then Pm = 1 

Else  ))](*000535.0)))exp(0.1(*316.6(941.1exp(1/1 2CSBTPm 
  

Source: Ryan, K.C.; Reinhardt, E.D. 1988. Predicting post fire mortality of seven western conifers.  
Canadian Journal of Forest Research 18:1291-1297. 
_____________________________________________________ 
Equation 3: 
Spruces other than Engelmann  
Same as Equation 1 but constrains mortality to at least 80% 
Source: Ryan, K.C.; Reinhardt, E.D. 1988. Predicting post fire mortality of seven western conifers.  
Canadian Journal of Forest Research 18:1291-1297. 
_____________________________________________________ 
Equation 4: 
Quaking Aspen.   CH=char height  (CH= Flame height/1.8), DBH (in.) 
If Fire Severity = “Low” then  

 )407.4)12*54.2**07.0()54.2*(*251.0exp((1/1  CHDBHPm  

If Fire Severity <> “Low” then 

 )157.2)12*54.2**118.0()54.2**0858.0exp((1/1  CHDBHPm        

Source: Brown, J. K.; DeByle, N. V. 1987. Fire damage, mortality, and suckering in aspen. Canadian 
Journal of Forest Research. 17: 1100-1109.                                 
_____________________________________________________ 
Equation 5: 
Longleaf pine: BT=bark thickness (cm);  SCH=proportion of crown volume scorched (0-10).  
BT=0.435+(0.031*DBH(cm)) 
If SCH= 0 then Pm=0 
If SCH>0 then Pm=1/(1+e^0.169+(5.136*BT)+(14.492*BT^2)-(0.348*SCH^2))  
Cutoff for mortality is 0.3 rather than 0.5. 
Source: Wang, GG; Wangen, S;  Reinhardt, E; Waldrop, TA, Outcalt, KW; Walker, JL; Brockway, DG; 
Haywood, JD; Hiers, JK. 2007. Modify FOFEM for use in the Coastal Plain Region of the Southeastern 
US. JFSP Program Report: 05-4-3-06. Available at: http://www.firescience.gov/projects/05-4-3-
06/project/05-4-3-06_final_report.pdf 
 
This equation was one of 14 equations developed by Wang and others for predicting probability of 
longleaf mortality from low severity prescribed fire in the Southeastern Plains, Middle Atlantic Coastal 
Plains and Southern Coastal Plain in the southeastern U.S. Some of the other longleaf mortality 
equations included in Wang and others JFSP report have better predictive power but require input of 
relative humidity, an input not currently available in FOFEM. While not the optimal selection the 
equation from Wang, et al. that FOFEM uses in this version performs better than the equation used in 
previous version of FOFEM and was selected because it could be easily included incorporated in 
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FOFEM. When FOFEM is updated to allow more complex inputs for predicting tree mortality and/or 
new longleaf pine mortality equations are developed FOFEM will be updated according. 
_____________________________________________________ 
Equation 10: 
White fir:   CLS=Crown length scorched (%) 

   )000017.0CLS()00184.0CLS()0956.0CLS(5083.3exp1/1 32 mP  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation 11: 
Subalpine fir and grand fir:   CVS = crown volume scorched (%) 

   )000035.0CVS()0047.0*CVS()2071.0*CVS(6950.1exp1/1 32 mP  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation 12: 
Incense cedar:   CLS = crown length scorched (%) 

   )000007172.0CLS(2466.4exp1/1 3 mP  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation 14: 
Western larch:  CVS = crown volume scorched (%) 

   )0489.0*()0327.0CVS(6594.1exp1/1 dbhPm   

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation 15: 
Engelmann spruce:  CVS = crown volume scorched (%) 

   )0445.0CVS(0845.0exp1/1 mP  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation #16 
Red fir:    CLS = crown length scorched (%) 

   )000004059.0CLS(3085.2exp1/1 3 mP  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation 17: 
Whitebark pine and lodgepole pine:   CVS = crown volume scorched (%) 

   )0266.0*()000025.0CVS()0033.0*CVS()1387.0*CVS(3268.0exp1/1 32 dbhPm 

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
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Equation 18: 
Sugar pine:   CLS = crown length scorched (%) 

   )000814.0CLS(0588.2exp1/1 2 mP  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation 19: 
Ponderosa/Jeffrey pine:   CVS = crown volume scorched (%) 

   )000004093.0CVS(7103.2exp1/1 3 mP  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation 20: 
Douglas-fir:   CVS = crown volume scorched (%) 

   )000019.0CVS()0022.0*CVS()0906.0*CVS(0346.2exp1/1 32 mP  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 

Estimating Tree Mortality - “Post-fire” 

Tree mortality using the post-fire injury option is computed using algorithms developed by Sharon Hood. 
Each algorithm is species specific and uses additional variables than the main mortality option to more 
accurately post-fire tree mortality. The mortality models in this option are more accurate than the 
models in the main mortality window; however, the inputs necessary to run these models may not be 
known. These models predict tree mortality occurring within 3 years of the fire.  

The models were developed using these potential variables: dbh, crown damage percent, cambium kill 
rating (CKR), and bark beetle attacks. 

Crown damage: a value from 0 to 100 based on percent total crown length scorched, percent total 
crown volume scorched or percent total crown volume killed (bud kill). 

DBH: diameter at breast height in inches. 

CKR: Cambium Kill Rating. A value from 0 to 4, obtained by sampling a small section of the cambium 
at ground line at four evenly spaced locations around the tree. CKR is the number of dead cambium 
samples. 

Bark beetles: presence/absence of bark beetle attack signs such as boring dust and pitch tubes. See 
equations below for species included in model development. 

When predicting tree mortality, the post-fire injury option depends on a user entered Probability 
Mortality Cutoff value. The logistic regression models compute a predicted probability of mortality (Pm) 
for each tree entered. This is a value between 0 and 1. Using the cutoff value entered, FOFEM predicts 
that trees with Pm values above the cutoff are dead and trees with Pm values below the cutoff are alive.   

For the vast majority of tree species, the percentage crown needle scorch and crown bud kill are equal. 
Therefore, the term crown scorch has been used throughout FOFEM to indicate the level of post-fire 
crown injury.  Exceptions to this in the post-fire injury species list include western larch, ponderosa pine, 
and Jeffrey pine. The western larch algorithm was developed using crown needle scorch data. Actual 
crown bud kill percentage was likely lower than the needle scorched percentage.  For ponderosa and 
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Jeffrey pine, both crown needle scorch and crown bud kill was assessed. Therefore, both a scorch and a 
kill mortality model are included. The kill model is more accurate than the scorch model because it 
reflects the true crown injury level and the ability of the tree to recover its crown over time. However, 
one cannot assess crown kill until the first bud break after the fire. If post-fire tree mortality must be 
assessed before bud-break, the scorch model can be used. See the Crown Scorch discussion for more 
information. 

The mean, standard error, median, and range of crown scorch and DBH by species of trees used to 
develop post-fire mortality models are shown below. Species are listed in order of increasing bark 
thickness using bark thickness equations in FFE-FVS. 

 

Species 
No. of 
trees 

Type1 
Crown Scorch % DBH (cm) 

Mean +SE Md Range Mean +SE Md Range 

Lodgepole pine 2038 V 19 ± 0.7 0 0-100 20.8 ± 0.1 19.6 10.2-56.4 

Whitebark pine 148 V 24 ± 2.9 2 0-100 22.9 ± 0.6 22.5 12.4-58.9 

Engelmann spruce 223 V 30 ± 2.2 20 0-100 33.2 ± 1.1 30.2 12.7-85.1 

Red fir 209 L 42 ± 1.8 46 0-89 42.1 ± 1.2 38.9 15.2-104.6 

Subalpine fir 947 V 65 ± 1.3 85 0-100 19.4 ± 0.2 17.5 10.2-75.2 

White fir 2304 L 67 ± 0.5 74 0-100 59.2 ± 0.4 56.9 15.2-152.7 

Incense cedar 783 L 40 ± 1.1 38 0-98 51.6 ± 0.9 43.7 25.4-166.4 

Yellow pine2 4115 V 62 ± 0.6 80 0-100 47.1 ± 0.4 40.1 9.7-178.1 

Douglas-fir 1409 V 33 ± 0.9 20 0-100 33.2 ± 0.5 30.0 10.2-105.4 

Western larch 389 V 15 ± 1.3 0 0-100 38.8 ± 0.7 39.4 10.2-98.8 

Sugar pine 719 L 40 ± 1.1 41 0-98 73.3 ± 1.0 70.4 25.6-188.0 
1 L = crown length; V = crown volume 
2 Includes ponderosa and Jeffrey pine  

Mortality Equations – “Post-fire”  

________________________________ 
Equation WF: 
White fir post-fire:   CKR = Cambium Kill Rating, CLS = crown length scorched (%), beetles = ambrosia 
beetle (attacked value = 1; unattacked value = -1), DBH (in.) 

   )5209.0*()019.0*()3019.0()00000628.0(5964.3exp1/1 3 beetlesDBHCKRCLSPm   

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation SF: 
Subalpine fir and grand fir post-fire:  CKR = Cambium Kill Rating, CVS = crown volume scorched (%) 

   )3554.1()000004587.0CVS(6036.2exp1/1 3  CKRPm  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
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Equation IC: 
Incense cedar post-fire:   CKR = Cambium Kill Rating, CLS = crown length scorched (%) 

   )5428.0()000007274.0(6465.5exp1/1 3  CKRCLSPm  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation WL: 
Western larch post-fire:   CKR = Cambium Kill Rating, CVS = crown volume scorched (%) 

   )6266.0()0004.0CVS(8458.3exp1/1 2  CKRPm  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation WP:   
Whitebark pine and lodgepole pine post-fire:  CKR = Cambium Kill Rating, CVS = crown volume 
scorched (%), DBH (in.) 

   )0485.0*()2843.0()000004459.0CVS(4059.1exp1/1 23 DBHCKRPm   

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation ES: 
Engelmann spruce post-fire:   CKR = Cambium Kill Rating, CVS = crown volume scorched (%) 

   )1596.1()0405.0CVS(9791.2exp1/1  CKRPm  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation SP: 
Sugar pine post-fire:    CKR = Cambium Kill Rating, CLS = crown length scorched (%), beetles = Red 
turpentine beetle and/or Mountain pine beetle (attacked value = 1; unattacked value = -1) 

   )8485.0*()0386.0()000642.0(7598.2exp1/1 32 beetlesCKRCLSPm   

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation RF: 
Red fir post-fire:   CKR = Cambium Kill Rating, CLS = crown length scorched (%) 

   )0668.1()000005989.0(7515.4exp1/1 3  CKRCLSPm  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
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Equation DF: 
Douglas-fir post-fire:   CKR = Cambium Kill Rating, CVS = crown volume scorched (%), beetles = 
Douglas-fir beetle (attacked value = 1; unattacked value =0) , DBH (in.) 
















































)0492.0**()7959.0*()031.0*(

)5840.0()000018.0CVS()0019.0CVS()07.0CVS(8912.1
exp1/1

32

beetlesDBHbeetlesDBH

CKR
Pm  

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation PP:  
Ponderosa pine and Jeffrey pine (scorch) post-fire:  CKR = Cambium Kill Rating, CVS = crown volume 
scorched (%), beetles = mountain pine beetle, red turpentine beetle, or ips beetle (attacked value = 1; 
unattacked value =0) 

   )5873.1*()5130.0()000376.0CVS(1914.4exp1/1 2 beetlesCKRPm   

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 
_____________________________________________________ 
Equation PK: 
Ponderosa pine and Jeffrey pine (kill) post-fire:  CKR = Cambium Kill Rating, CVK = crown volume killed 
(%) 
beetles = mountain pine beetle, red turpentine beetle, or ips beetle (attacked value = 1; unattacked 
value =0) 

   )6075.1*()4573.0()000567.0(5729.3exp1/1 2 beetlesCKRCVKPm   

Source: Hood, S. M. (Principal Investigator), 2008, Delayed Tree Mortality following Fire in Western 
Conifers, JFSP # 05-2-1-105 

Canopy Cover 

Canopy Cover is calculated using crown width equations, which are then converted to crown area. The 
equations use coefficients particular to tree species (see table below). Once crown cover is calculated 
for individual trees and then accumulated for the tree list, an overlap correction factor is applied.  

Equation for trees over 4.5 feet: 

CW = A * DB  
where;  

CW = Crown Width (ft) 
A    = A Coefficient 
D    = Diameter (in.) 
B    = B Coefficient 

 Equation for trees under 4.5 feet : 

CW = R * D   
where;  

CW = Crown Width (ft)  
R    = Ratio Coefficient  
D    = Diameter (in.) 

See the FOFEM tree species file (FOF_SPP.dat) in the installation folder for more information. 



FOFEM 6.3 User Guide 

60 
 

The overlap calculation is: 

CovProp = (Cov / 43560) 
PctCov  = 100.0 * ( 1.0 -  expCovProp)  
where;  

CovProp = Proportion of each acre with crown cover 
Cov          = total accumulated crown cover (ft2) 
PctCov    = percent crown cover adjusted for overlap (ac-1) 

Coefficients for tree crown widths are based on data from R6 Permanent Plot Grid Inventory. 

Eq no. 
Species 

Code A Coeff. B Coeff. 
Ratio 
Coeff. 

1 "SF" 3.9723 0.5177 0.473 

2 "WF" 3.8166 0.5229 0.452 

3 "GF" 4.187 0.5341 0.489 

4 "AF" 3.2348 0.5179 0.385 

5 "RF" 3.1146 0.578 0.345 

7 "NF" 3.0614 0.6276 0.32 

8 "YC" 3.5341 0.5374 0.331 

9 "C" 4.092 0.4912 0.412 

10 "S" 3.6802 0.494 0.412 

11 "LP" 2.4132 0.6403 0.298 

12 "JP" 3.2367 0.6247 0.406 

13 "SP" 3.061 0.6201 0.385 

14 "WP" 3.4447 0.5185 0.476 

15 "PP" 2.8541 0.64 0.407 

16 "DF" 4.4215 0.5329 0.517 

17 "RW" 4.4215 0.5329 0.517 

18 "RC" 6.2318 0.4259 0.698 

19 "WH" 5.4864 0.5144 0.533 

20 "MH" 2.9372 0.5878 0.253 

21 "BM" 7.5183 0.4461 0.815 

22 "RA" 7.0806 0.4771 0.73 

23 "WA" 7.0806 0.4771 0.73 

24 "PB" 5.898 0.4841 0.601 

25 "GC" 2.4922 0.8544 0.14 

26 "AS" 4.091 0.5907 0.351 

27 "CW" 7.5183 0.4461 0.815 

28 "WO" 2.4922 0.8544 0.14 

29 "J" 4.5859 0.4841 0.468 

30 "LL" 2.1039 0.6758 0.207 

31 "WB" 2.1606 0.6897 0.255 

32 "KP" 2.1451 0.7132 0.248 
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33 "PY" 4.5859 0.4841 0.468 

34 "DG" 2.4922 0.8544 0.14 

35 "HT" 4.5859 0.4841 0.468 

36 "CH" 4.5859 0.4841 0.468 

37 "WI" 4.5859 0.4841 0.468 

38 "" 4.4215 0.5329 0.517 
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Reinhardt, E.D.; K.C. Ryan. 1988. How to estimate tree mortality resulting from under burning. Fire 
Management Notes 49(4):30-36. 

Ryan, K.C.; Reinhardt, E.D. 1988. Predicting post fire mortality of seven western conifers.  Canadian 
Journal of Forest Research 18:1291-1297.  

Van Wagner, C.E. 1973. Height of crown scorch in forest fires. Canadian Journal of Forest Research 
3:373-378. 

Scientific Content - Fuel Consumption 

Default Fuelbeds 

Default fuelbeds include fuel loading for most, if not all, components.  Fuel loads are based on cover 
type and on fuel type (natural or slash fuels).  The default loads can be adjusted (using the Typical, Light, 
Heavy adjustment buttons) or replaced with a user value.  It is always good to enter fuel loadings 
directly if you have a good estimate, since fuels vary greatly within cover type.    

To provide default fuel loads, an exhaustive search of fuels literature was conducted. The resulting 
database (Mincemoyer 2002) was added in FOFEM 5.3.   

Fuel Consumption 

FOFEM predicts the quantity of fuel consumed by prescribed fire or wildfire.  Fuel components include 
duff, litter, 0 - ¼ inch, ¼ - 1 inch, 1 - 3 inch, 3 inch plus dead woody fuels (sound and rotten), herbaceous 
fuels, shrubs, and canopy fuels affected by crown fire.  Mineral soil exposed by fire as a result of duff 
and litter consumption is also predicted. 

One major assumption FOFEM makes in predicting fuel consumption is that the entire area experiences 
the fire.  FOFEM does not predict fire effects for patchy or discontinuous burns.  For these situations, 
results should be weighted by the percent of the area burned. 

FOFEM uses the Burnup model to predict consumption of woody fuels.  Consumption of other fuels is 
predicting using a variety of empirical equations and rules of thumb.  Previous versions of FOFEM 
included a number of woody fuel consumption algorithms that were used in different cover types, 
geographic regions, and fuel types.  Although these earlier, empirical algorithms may perform better 
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than Burnup in certain specific circumstances, Burnup is felt to provide a more logically consistent 
approach to fuel consumption estimation.    

Litter Consumption 

In most cases litter consumption is simulated in Burnup.  

Equations are selection using a decision process that in part based on region. See Decision Dependency 

_______________________________________________ 
Equation 999: 
The consumption of litter is calculated by Burnup. Generally 100% of the litter is consumed. 
Sources: Albini, F.A.; Brown, J.K.; Reinhardt, E.D.; Ottmar, R.D. Calibration of a Large Fuel Burnout 
Model. International Journal of Wildland Fire 5(3):173-192, 1995. Albini, F.A.; Reinhardt, E.D. 
Improved Calibration of a Large Fuel Burnout Model.  International Journal of Wildland Fire 7(1): 21-
28, 1997. 
_______________________________________________ 
Equation 223: 
In the Southeast region Litter Load Consumed = Prefire Litter Load * 0.8. The consumed litter load is 
used as an initial input to Burnup, which simulates 100% litter consumption. 
Source: Estimate based on personal communication with managers and Reid, A.M.; Robertson, K.M. 
and Hmielowski, T.L. 2012. Predicting litter and live herb fuel consumption during prescribed fires in 
native and old-field upland pine communities of southeastern United States. Can. J. For. Res. 42: 1611-
1622. 
McDaniel, V. L; Perry, R.W.; Guldin, J. M. 2015 (In prep). Evaluation of FOFEM default fuel loading and 
consumption estimates in forest and woodland communities of Arkansas. 
Prichard, S. J.; Karau, E.C.; Ottmar, R.D.; Kennedy, M.C.; Cronan, J.B.; Wright, C.S.; Keane, R.E. 2014. 
Evaluation of the CONSUME and FOFEM fuel consumption model in pine and mixed hardwood forests 
of the eastern United States. Can. J. For. Res. 44: 784-795. 
_______________________________________________ 

 

Duff Consumption  

A number of different duff consumption algorithms are incorporated into FOFEM6. Separate predictions 
are made of percent duff consumption and duff depth consumed.  These equations, their sources, and 
the circumstances under which each is used by FOFEM are summarized below.  

Equations are selection using a decision process that in part based on region, fuel category, moisture 
method and Cover Group . See Decision Dependency 

_______________________________________________ 
Equation 1:    
Used for predicting percent duff consumption (%DR) from lower duff moisture (LDM) content in the 
Interior West and Pacific West for activity fuels and natural fuels other than ponderosa pine cover 
groups.    
If LDM <=160% then %DR = 97.1 - 0.519 LDM,  
If LDM > 160% the %DR = 13.6,  
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
 _______________________________________________ 
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Equation 2:     
Used for predicting percent duff consumption (%DR) from entire or average duff moisture (EDM) 
content in the Interior West and Pacific West.  This equation is also the default equation that FOFEM 
uses when it cannot find another duff consumption algorithm. 
%DR = 83.7 - 0.426 EDM                       
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
 ________________________________________________ 
Equation 3:  
Used for predicting percent duff consumption (%DR) from NFDR 1000 hour moisture  (NFDTH) content 
in the Interior West, Pacific West, and North East.    
%DR = 114.7 - 4.20 NFDTH                             
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
Equation 4: 
Used for predicting percent duff consumption (%DR) from lower duff moisture (LDM) content in the 
Interior West and Pacific West for natural fuels in the ponderosa pine groups. 
%DR = 89.9 - 0.55 LDM                                
Source: Harrington, M.G. 1987. Predicting reduction of natural fuels by prescribed burning under 
ponderosa pine in southeastern Arizona. USDA Forest Service Res. Note  RM-472. 
________________________________________________ 
Equation 5: 
Used for predicting duff depth consumption (DR) from lower duff moisture (LDM) content in the 
Interior West and Pacific West (DPRE = pre fire duff depth). 
DR = 1.028 - .0089 LDM + 0.417 DPRE                  
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
Equation 6:  
Used for predicting duff depth consumption (DR) from entire or average duff moisture (EDM) content 
in the Interior West and Pacific West (DPRE = pre fire duff depth). This equation is also the default 
equation that FOFEM uses when it cannot find another duff consumption algorithm. 
DR = 0.8811 - 0.0096 EDM + 0.439 DPRE                
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
     ________________________________________________ 
Equation 7: 
Used for predicting duff depth consumption (DR) from NFDR 1000 hour moisture (NFDTH) content in 
the Interior West, Pacific West, and North East (DPRE = pre fire duff depth).      
DR = 1.773 - 0.1051 NFDTH + 0.399 DPRE               
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
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Equation 15:  
Used for predicting residual duff depth (RD) from average duff moisture (EDM) and preburn duff 
depth (DPRE). (PINE=1 if cover group is jack pine or 0 if other). This equation was based on data 
assimilated from many studies and is used where a more site specific equation is lacking.        
RD = -0.791 + .004 EDM + 0.8 DPRE + 0.56 PINE        
Source: Reinhardt, E.D., Keane, R.E., Brown, J.K., Turner, D.L. 1991. Duff consumption from prescribed 
fire in the U.S. and Canada: a broadly based empirical approach. Proceedings, 11th Conference on Fire 
and Forest Meteorology. 
 _________________________________________________ 
Equation 16:   
Used in the Southeast except in pocosin cover groups. %DR=% duff reduction, WPRE=litter load+duff 
load+1-hr load+10-hr load, EDM=entire duff moisture, L=preburn litter load, W=load of litter+duff 
consumed 
W = 3.4958 + (0.3833 WPRE) – (0.0237 EDM) – (5.6075/WPRE)  
If W <= L then %DR = 0  
If W > L then %DR = ((W - L)/(WPRE - L)) * 100% 
Source: Hough, W.A. 1978. Estimating available fuel weight consumed by prescribed fires in the south. 
USDA Forest Service Res. Pap. SE-187. 
 ________________________________________________ 
Equation 17: 
Piles: FOFEM assumes nominal duff consumption in pile burning (Below the piles). %DR=% duff 
reduction 
%DR = 10% 
Source: Anecdotal evidence 
________________________________________________ 
Equation 19: 
Chaparral: FOFEM assumes complete duff consumption in chaparral types. %DR=% duff reduction 
%DR = 100% 
Source: Anecdotal evidence 
________________________________________________ 
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Equation 20:  
Pocosin: Calculates root mat consumption for deep organic soils in the pocosin cover groups in the 
southeast US.  

NOTE: This equations does not predict consumption of muck soils underlying the root mat.  

The root mat and is divided into layers of no more than 4” thickness. Consumption of each layer is 
calculated separately then summed as the total estimated consumption. Moisture content of layer 1 
(MCLayer) is the duff moisture content set on the UI. Moisture content of layers 2, 3, 4, and 5 are 3%, 
9%, 18%, 30%, respectively, greater than the moisture content of layer 1. Moisture content of layers 6 
and greater are 12% higher than each previous layer. Percent consumption of each layer is calculated 
using the following logic: 

If MCLayer <10 then 100% consumption 

If MCLayer > 10 and MCLayer <30 then consumption = Load * (0.949932 + ((30- MCLayer)*0.00251)) 

If MCLayer > 30 and MCLayer < 140 then consumption =  

Load *(1/(1 + (EXP(-1*(2.033-(0.043* MCLayer) + (0.44*Mineral Content*)))))) 

If MCLayer > 140 and MCLayer < 170 then consumption = Load * (0.143441-((MCLayer -140)*0.0049)) 

If MCLayer > 170 then 0% consumption 

*Mineral content is set to 5% 

Source: Reardon 2016, per. comm.; Reardon, James; Hungerford, Roger; Ryan, Kevin 2007. Factors 
affecting sustained smoldering in organic soils from pocosin and pond pine woodland wetlands. 
International Journal of Wildland Fire. 16: 107-118.  

________________________________________________ 

Mineral Soil Exposure 

The amount of mineral soil exposed by a fire is predicted using these equations: 

_________________________________________________ 
Equation 9: 
Used for predicting % mineral soil exposure (MSE) from lower duff moisture (LDM) content in activity 
fuels in the west.     
If LDM <= 135% then MSE = 80.0 - 0.507 LDM,                  
If LDM > 135% then MSE =23.5 - 0.0914 LDM,  
Source:  Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
Equation 10: 
Used for predicting % mineral soil exposure (MSE) from average duff moisture (EDM) content in the 
west.  This is also the default equation FOFEM uses for predicting mineral soil exposure.     
MSE = 167.4 - 31.6 log(EDM)                          
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
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Equation 11:  
Used for predicting % mineral soil exposure (MSE) from NFDR 1000 hour moisture (NFDTH) content in 
activity fuels in the west.       
MSE = 93.3 - 3.55 NFDTH                              
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
Equation 12: 
Used for % predicting mineral soil exposure (MSE) from NFDR 1000 hour moisture (NFDTH) content in 
natural fuels in the west.      
MSE = 94.3 - 4.96 NFDTH                              
Source:  Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
Equation 13: 
Used for % predicting mineral soil exposure (MSE) from lower duff moisture (LDM) content in natural 
fuels in the west. 
MSE = 60.4 - 0.440 LDM                               
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
Equation 14:  
Used for % predicting mineral soil exposure (MSE) from percent duff reduction (%DR) – a robust 
equation used when other information is lacking.      
MSE = -8.98 + 0.899 %DR                              
Source: Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel 
consumed by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 
________________________________________________ 
Equation 18: 
Piles: FOFEM assumes nominal % mineral soil exposure (MSE) in pile burning (beneath the piles).        
MSE = 10% 
Source: Anecdotal evidence 
________________________________________________ 
Equation 202:  
Pocosin group: For deep organic soils in the pocosin type, no mineral soil is exposed (MSE).         
MSE   = 0%    
Source: Hungerford 1996, personal communication 
_________________________________________________ 
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Herbaceous Consumption 

Herbaceous fuels generally are a small component of the total fuel load.  However, for completeness, 
especially in modeling emission production, their consumption is computed by FOFEM. Also see Decision 
Dependency 

____________________________________________________ 
Equation 22:  
All the herbaceous fuels are assumed to burn. 
Source: Anecdotal evidence 
____________________________________________________ 
Equation 221:   
If the cover group is grass, and the season of burn is spring, only 90% of the herbaceous fuels are 
consumed. 
Source: Anecdotal evidence 
____________________________________________________ 
Equation 222:  

For the Southeast region Herb Load Consumed = -0.059 + (0.004 * Litter Fuel Load) + (0.917 * Herb 
Fuel Load) 

Source:  Reid, A.M.; Robertson, K.M. and Hmielowski, T.L. 2012. Predicting litter and live herb fuel 
consumption during prescribed fires in native and old-field upland pine communities of southeastern 
United States. Can. J. For. Res. 42: 1611-1622. 

 

Shrub Consumption 

Shrub consumption is modeled using these equations. Also see Decision Dependency 

____________________________________________________ 
Equation 233: 
If the cover group is sagebrush and the season is fall, shrub consumption is 90%. 
Source: Anecdotal evidence 
____________________________________________________ 
Equation 232: 
If the cover group is sagebrush and the season is other than fall, shrub consumption is 50%. 
Source: Anecdotal evidence 
___________________________________________________ 
Equation 231: 
For cover group not sagebrush but dominated by shrubs, that is shrub group (except in the southeast), 
shrub consumption is assumed to be 80%. 
Source: Anecdotal evidence 
____________________________________________________ 
Equation 23:    
For cover groups not dominated by shrubs, shrub consumption is set to 60%. 
Source: Anecdotal evidence 
____________________________________________________ 
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Equation 233: 
For the southeastern region, for the pocosin cover group, in spring or winter shrub consumption is 
90%. 
Source: Anecdotal evidence 
____________________________________________________ 
Equation 234: 
Used to predict percent shrub consumption for non-pocosin group in the southeast region. 
Percent consumption = ((( 3.2484 + 0.4322 * preburn litter and duff loading + .6765 * preburn shrub 
and regeneration loading - .0276* duff moisture – ( 5.0796 / preburn litter and duff loading) – litter 
and duff consumption ) / preburn shrub and regeneration loading ) * 100%. 
Sources: Hough, W.A. 1968. Fuel consumption and fire behavior of hazard reduction burns. USDA 
Forest Service Res. Pap. SE-36. Hough, W.A. 1978. Estimating available fuel weight consumed by 
prescribed fires in the south. USDA Forest Service Res. Pap. SE-187. 

____________________________________________________ 
Equation 235:  
For the southeastern region, for the pocosin cover group, in summer or fall shrub consumption 80%. 
Source: Anecdotal evidence 
 

Down Woody Fuel Consumption 

All down woody fuel consumption is modeled in Burnup 

____________________________________________________ 
Equation 999: 
Estimates of woody fuel consumption derived in Burnup. 
Sources: Albini, F.A.; Brown, J.K.; Reinhardt, E.D.; Ottmar, R.D. Calibration of a Large Fuel Burnout 
Model. International Journal of Wildland Fire 5(3):173-192, 1995. Albini, F.A.; Reinhardt, E.D. 
Improved Calibration of a Large Fuel Burnout Model.  International Journal of Wildland Fire 7(1): 21-
28, 1997. 
____________________________________________________ 

 

Canopy Fuel Consumption 

FOFEM does not predict whether a crown fire will occur and canopy fuels will be consumed.  It requires 
the user to estimate the proportion of the stand affected by crown fire.  FOFEM simply applies this 
proportion to the canopy foliage and one-half of the canopy 0-1/4 inch branch wood, so that 
consumption of these fuels is represented for purposes of estimating smoke production or carbon 
budget. 

    ____________________________________________________ 
Equation 37: 
Consumed foliage = (Crown Burn %/100)* Foliage 
Source: Anecdotal evidence 
_____________________________________________________ 
Equation 38: 
Consumed branch wood = (Crown Burn %/100) * Branch * 0.5 
Source: Anecdotal evidence 
_____________________________________________________ 
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Carbon  

Carbon loading in the carbon report is calculated using two equations: 
 
1) For down woody material, herbaceous, shrub, branch and foliage loading: 

Carbon = loading * 0.50 
 

Source;: Penman, J.; Gytarsky, M.; Hiraishi, T.; Krug, T.; Kruger, D.; Pipatti, L.; Buendia, L.; Miwa, K.; 
Ngara, T.; Tanabe, K.; Wagner, F., eds. 2003. Good practice guidance for land use, land-use change and 
forestry. Intergovernmental Panel on Climate Change, Technical Support Unit. Institute for Global 
Environmental Strategies, Hayama, Kanagawa, Japan. http://www.ipcc-nggip.iges.or.jp 

 
2) For duff and litter: 

Carbon = loading * 0.37  
 

Source; Smith, James E.; Heath, Linda S. 2002. A model of forest floor carbon mass for United States 
forest types. Res. Pap. NE-722. Newtown Square, PA: U.S. Department of Agriculture, Forest Service, 
Northeastern Research Station. 37 p. 

 

Moisture Regime 

Fuel moisture can be entered directly for duff, 10 hour (1/4-1 inch) woody fuel, and 3+ inch woody fuel.  
Fuel moisture of 1 hour and 100 fuels are set to 2 percent lower and 2 higher, respectively, of the 10 
hour moisture.  

Users can also select a moisture regime based on western systems– Wet, Moderate, Dry, Very Dry - to 
have these moisture contents set by default.  

 

Regime Duff 10 Hr 3+ in. Soil 

Wet 130 22 40 25 

Moderate 75 16 30 15 

Dry 40 10 15 10 

Very Dry 20 6 10 5 

 

For duff moisture, users can enter entire duff moisture content, lower duff moisture content, NFDR 
1000 hour index values, or adjusted NFDR 1000 hour values (Ottmar and Sandberg 1983).  If you want to 
set fuel moistures for all woody fuel size classes, or separately for sound and rotten fuels, you can run 
Burnup from an input file, bypassing the FOFEM user interface.  See Running Burnup from an input File 
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Decision Dependency 

This section details the relationship between fuel components and the input variables they depend on 
to select consumption equations.  Not all fuel components base equation selection on input variables 
(e.g., down woody debris).   

 Herbaceous Calculations 
     Cover Group 
     Season   

 Shrub Calculations 
     Cover Group  
     Season  
     Region   

 Duff Calculations 
     Region 
     Cover Group 
     Fuel Type 
     Moisture Regime 

 Litter, Crown Branch/Foliage, Down Woody Calculations 
     This fuel components are always calculated using the same equations regardless of Cover Group, 

Season, etc. 

Cover Groups 

Cover Group is used to determine consumption formulas for herbaceous, shrub and duff fuel loading, in 
turn fuel consumption is used to compute smoke emission amounts and simulate soil heating.    

The codes are assigned to some but not all cover types, for example cover type SAF 001 Jack Pine is 
assigned a cover group code of RJP      

To see the assigned cover group codes for each cover type you can look in FOFEM’s fof_saf.csv, 
fof_nvcs.csv, fof_flm.csv or fof_fccs.csv files for a reference. The files contain cover type codes as well as 
fuel loads and equation information for SAF/SFM, NVCS, FLM and FCCS cover classifications. The .csv 
text files can be found in the FOFEM install directory, you can print them out or view them with a text 
editor; be careful not to alter them in any way. Each row of the file represents a single cover type with 
its name contained in the same line. If a cover type belongs to a cover group it will have a short 
character code in the last data column of the row.  

Type Short code Long code 

Grass GG GrassGroup 

Shrub SG   ShrubGroup 

Sagebrush SB   Sagebrush 

Ponderosa pine PN Ponderosa 

Pocosin PC Pocosin 

Balsam, Black, Red, White Spruce BBS BalBRWSpr 

Red, Jack Pine RJP RedJacPin 

White Pine Hemlock WPH WhiPinHem 
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For more details concerning how cover groups are used to determine consumption see: Cover Groups, 
Decision Dependency, Duff Consumption, Herbaceous Consumption and Shrub Consumption 

Burnup      

Burnup is a physical model of heat transfer and burning rate of woody fuel particles as they interact over 
the duration of a burn.  Duff consumption rate is assumed to be constant (Frandsen 1991).  Duff 
consumption amount is computed as described in the Duff Consumption section, depending on cover 
type and duff moisture.  Duff consumption duration is computed from total consumption and 
consumption rate. At each iteration of the Burnup model, fuel consumption of each woody fuel size 
class is determined by modeling the heat transfer at intersections with other fuel particles and with the 
duff.  Fire intensity is derived from the combustion of fuels in each time step.  The fire is assumed to go 
out when the overall fire intensity is too low to sustain further combustion.  Burnup thus provides 
estimates of total fuel consumption by size class, and also of consumption rate and fire intensity over 
time. Burnup outputs are labeled 999 on the FOFEM reports. 

For more information see See: Albini, F.A.; Reinhardt, E.D. (1995) Modeling Ignition and Burning Rate of 
Large Woody Natural Fuels.  International Journal of Wildland Fire 5(2):81-91. 

Running Burnup from an Input File 

Burnup can accept as input any number of fuel classes, defined by characteristics including loading, 
moisture content, surface area to volume ratio, and density. Normally when creating reports and graphs 
from the FOFEM user interface, Burnup is run using a number of simplified assumptions.  For example, 
only two fuel densities are used, representing sound and rotten wood.  However, the full functionality of 
Burnup is available to users by running Burnup from an input file.  If you have a lot of detailed fuel data, 
you may wish to use this option. 

In order to run Burnup from a file, you must first create that file.  You can create a sample input file by 
using the menu item Options>Create Burnup Sample Input File. The sample file will include duff, litter, 
and woody fuel loading, and associated moistures as set on the user interface. Herb, shrub, foliage and 
branch material are not included in the sample file. They can be added is desired. Select Options>Run 
Burnup From Input File to run the Burnup input file you create. Predicted consumption will be saved by 
default to a file called BurnCons.txt, and emissions data to a file called BurnEmis.txt.  These three files 
are described in more detail below. 

Also remember, that whether you edit the sample file or create your own, it must be a text file, so be 
sure to save it as such no matter what text editor of word processor you use.  

The file has two sections. The first section describes simulation parameters and the second section 
describes the fuel components being simulated. 
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Sample Burnup Input File 

 

MAX_TIMES  3000    

INTENSITY(kW/m2) 50.00 

IG_TIME(s)  60.00 

WINDSPEED(m/s)  0.00 

DEPTH(m)   0.30 

AMBIENT_TEMP(C)  27.00 

r0   1.83 

dr   0.40 

TIMESTEP(s)  15.00 

DUFF_LOAD(kg/m2) 11.459641 

DUFF_MOIST  1.000000 

dummy_file.nam 

 

1    1   5.76   18600.0  0.230  513.0  8200.00  2750.0  0.133  327.0  377.0   0.05 

1    2   6.27   18600.0  0.230  513.0  1480.00  2750.0  0.133  327.0  377.0   0.05 

1    3   11.8   18600.0  0.250  513.0   394.00  2750.0  0.133  327.0  377.0   0.05 

1    4   20.4   18600.0  0.270  513.0   105.00  2750.0  0.133  327.0  377.0   0.05 

1    5   14.73  18600.0  0.200  513.0    39.40  2750.0  0.133  327.0  377.0   0.05 

1    6    1.63  18600.0  0.500  224.0    39.40  2750.0  0.133  302.0  377.0   0.05 

1    7   14.73  18600.0  0.200  513.0    21.90  2750.0  0.133  327.0  377.0   0.05 

1    8    1.63  18600.0  0.500  224.0    21.90  2750.0  0.133  302.0  377.0   0.05 

1    9   14.73  18600.0  0.200  513.0    12.70  2750.0  0.133  327.0  377.0   0.05 

1   10    1.63  18600.0  0.500  224.0    12.70  2750.0  0.133  302.0  377.0   0.05 

1   11   14.73  18600.0  0.200  513.0     5.91  2750.0  0.133  327.0  377.0   0.05 

1   12    1.63  18600.0  0.500  224.0     5.91   2750.0 0.133  302.0  377.0   0.05 

 

 

An explanation of simulation parameters in the first section of the input file follows: 

Name Description Notes 

MAX_TIMES           The maximum number of iterations Burnup will 
compute.   

 

INTENSITY    Intensity of the igniting surface fire, kW/m2  

IG_TIME                 Residence time of the igniting surface fire, 
seconds 

 

WINDSPEED    Wind speed at the top of the fueled, 
meters/second 

 

DEPTH   Fueled depth, meters  

AMBIENT_TEMP    Ambient air temperature, degrees C  

R0 Fire environment minimum dimension 
parameter 

 

DR Fire environment increment temperature 
parameter 

 

TIMESTEP Time step for integration of burning rates (TIMESTEP * 
MAX_TIMES gives 
the maximum 
simulation period  

DUFF_LOAD Duff dry weight loading, kg/m2  

DUFF_MOIST        Duff moisture content, fraction dry weight  

dummy_file.nam      This  text must be here1   
1 The text “dummy_file.nam” must be located exactly as shown above in the sample file. As a 

file name it is not currently used in the version, but the text is used by FOFEM to separate 
the upper and lower sections of the file. 
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Each subsequent line represents one fuel component.  The rows of these lines contain, for that fuel 
component: 

Column No. Name Notes 

1 Must contain a “1”  

2 Index label  

3 Dry loading kg/m2 

4 Heat content kJ/kg 

5 Moisture content fraction dry load 

6 Oven dry mass density kg/m3 

7 Surface area to volume ratio m-1 

8 Heat capacity J/kg K 

9 Thermal conductivity W/m K 

10 Ignition temperature C 

11 Char temperature C 

12 Mineral ash fraction  

  

Sample Burnup Output Files 

Consumption 

Column 1: Fuel component 

       2: Preburn fuel load, kg/m2. 

       3: Moisture content, fraction 

       4: Sigma, surface area to volume ratio, m-1. 

       5: Time till ignition, seconds. 

       6: Time till burnout, seconds. 

       7: Post burn fuel load, kg/m2. 

 

    1     0.16   0.23     0.00      0.00000       11.53537     0.00000 

    2     0.04   0.23     0.00     13.19217      100.95903     0.00000 

    3     0.21   0.25     0.01     34.15087      649.39360     0.00000 

    4     0.15   0.20     0.10    149.06430      100.00000     0.04342 

    5     0.02   0.50     0.10     33.87733     6592.50000     0.00030 

    6     0.15   0.20     0.18    145.23737     1000.00000     0.08723 

    7     0.02   0.50     0.18     39.29486     6832.50000     0.00505 

    8     0.15   0.20     0.31    159.10688       10.00000     0.11398 

    9     0.02   0.50     0.31     43.91532     8790.54796     0.00945 

   10     0.15   0.20     0.68    167.31803      100.00000     0.13441 

   11     0.02   0.50     0.68     49.58486    20156.23184     0.01330 
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Emissions  

Column 1:  Time since ignition, seconds 

       2:  Intensity,  kw/m2. 

       3:  PM 2.5 production,   g/m2. 

       4:  PM 10 production,   g/m2. 

       5:  CH4 production,   g/m2. 

       6:  CO2 production,   g/m2. 

       7:  CO production,   g/m2. 

       8.  NOX production,   g/m2. 

       9.  SO2 production,   g/m2. 

       10: Fuel consumed in flaming combustion, kg/m2. 

       11: Fuel consumed in smoldering consumption, kg/m2. 

 

60   56.2436  1.3818  1.6305  0.7051  354.721   13.5953   1.5430  0.1801   0.1709  0.0414 

75   25.5548  0.6543  0.7720  0.3975   35.4842   8.7177   0.0000  0.0030   0.0000  0.0289 

90   20.4480  0.5555  0.6555  0.3375   30.1271   7.4016   0.0000  0.0020   0.0000  0.0245 

105  16.1658  0.4670  0.5511  0.2837   25.3291   6.2228   0.0000  0.0020   0.0000  0.0206 

120  13.7649  0.4276  0.5046  0.2598   23.1928   5.6980   0.0000  0.0020   0.0000  0.0189 

135  12.5357  0.4040  0.4767  0.2454   21.9113   5.3831   0.0000  0.0019   0.0000  0.0178 

150  11.6437  0.3869  0.4565  0.2350   20.9814   5.1547   0.0000  0.0019   0.0000  0.0171 

165  10.9653  0.3738  0.4411  0.2271   20.2741   4.9809   0.0000  0.0018   0.0000  0.0165 

180  10.4309  0.3635  0.4290  0.2208   19.7170   4.8441   0.0000  0.0018   0.0000  0.0161 

195   9.9534  0.3544  0.4182  0.2153   19.2192   4.7218   0.0000  0.0018   0.0000  0.0156 

210   9.5085  0.3458  0.4081  0.2101   18.7554   4.6078   0.0000  0.0018   0.0000  0.0153 

225   9.0807  0.3376  0.3984  0.2051   18.3094   4.4982   0.0000  0.0017   0.0000  0.0149 

240   8.6590  0.3295  0.3888  0.2002   17.8697   4.3902   0.0000  0.0017   0.0000  0.0146 

255   8.2383  0.3214  0.3792  0.1952   17.4312   4.2825   0.0000  0.0017   0.0000  0.0142 

270   7.8179  0.3133  0.3697  0.1903   16.9928   4.1748   0.0000  0.0016   0.0000  0.0138 

285   7.3926  0.3051  0.3601  0.1854   16.5494   4.0658   0.0000  0.0016   0.0000  0.0135 

300   6.9561  0.2967  0.3502  0.1803   16.0944   3.9540   0.0000  0.0016   0.0000  0.0131 

315   6.6379  0.2906  0.3429  0.1766   15.7626   3.8725   0.0000  0.0016   0.0000  0.0128 

330   6.6222  0.2902  0.3424  0.1763   15.7381   3.8665   0.0000  0.0015   0.0000  0.0128 

345   6.3491  0.2851  0.3364  0.1732   15.4616   3.7986   0.0000  0.0014   0.0000  0.0126 

360   6.0465  0.2793  0.3295  0.1697   15.1461   3.7211   0.0000  0.0013   0.0000  0.0123 

375   5.8318  0.2751  0.3246  0.1671   14.9203   3.6656   0.0000  0.0012   0.0000  0.0121 

390   5.6619  0.2719  0.3208  0.1652   14.7452   3.6226   0.0000  0.0010   0.0000  0.0120 

405   5.3910  0.2666  0.3146  0.1620   14.4599   3.5525   0.0000  0.0009   0.0000  0.0118 

420   5.1458  0.2620  0.3091  0.1591   14.2071   3.4904   0.0000  0.0009   0.0000  0.0116 

435   4.9960  0.2591  0.3057  0.1574   14.0509   3.4520   0.0000  0.0008   0.0000  0.0114 

 

Fuel Consumption Citations 

Albini, F.A.; Reinhardt, E.D. Modeling Ignition and Burning Rate of Large Woody Natural Fuels.  
International Journal of Wildland Fire 5(2):81-91, 1995. 

Albini, F.A.; Brown, J.K.; Reinhardt, E.D.; Ottmar, R.D. Calibration of a Large Fuel Burnout Model. 
International Journal of Wildland Fire 5(3):173-192, 1995.   

Albini, F.A.; Reinhardt, E.D. Improved Calibration of a Large Fuel Burnout Model.  International Journal of 
Wildland Fire 7(1): 21-28, 1997. 

Brown, J.K., Marsden, M.M., Ryan, K.C., Reinhardt, E.D. 1985. Predicting duff and woody fuel consumed 
by prescribed fire in the northern Rocky Mountains. USDA Forest Service Res. Pap. INT-337. 

Frandsen, W.H.  1991. Heat evolved from smoldering peat. International Journal of Wildland Fire 1:197-
204. 

Harrington, M.G. 1987. Predicting reduction of natural fuels by prescribed burning under ponderosa 
pine in southeastern Arizona. USDA Forest Service Res. Note  RM-472. 

Hough, W.A. 1968. Fuel consumption and fire behavior of hazard reduction burns. USDA Forest Service 
Res. Pap. SE-36.  
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Hough, W.A. 1978. Estimating available fuel weight consumed by prescribed fires in the south. USDA 
Forest Service Res. Pap. SE-187. 

Hungerford, R.D. 1996. personal communication. 

Mincemoyer, S. 2002. 

Ottmar, R.D., Sandberg, D.V. 1983. Estimating 1000-hour fuel moistures in the Douglas fir sub region. In: 
Proceedings of the 7th conference on fire and forest meteorology; Fort Collins, CO: 22-26. 

Reinhardt, E.D.; Keane, R.E.; Brown, J.K. First Order Fire Effects Model: FOFEM 4.0, User's Guide.  
General Technical Report INT-GTR-344. 1997.   

Reinhardt, E.D., Keane, R.E., Brown, J.K., Turner, D.L. 1991. Duff consumption from prescribed fire in the 
U.S. and Canada: a broadly based empirical approach. Proceedings, 11th Conference on Fire and Forest 
Meteorology. 

Scientific Content - Smoke Emissions 

Smoke Production 

The Burnup model was modified to provide separate estimates of flaming and smoldering consumption 
in each time step for each fuel component by assuming that flaming combustion cannot be sustained 
below an intensity of about 15 kW/m2 (Finney 2001).  Since Burnup computes a local intensity at the 
point of intersection of fuels, flaming and smoldering combustion can be simulated simultaneously – i.e. 
at fuel concentrations flaming combustion may occur in the same time step that smoldering combustion 
is occurring in the duff or in isolated woody fuels.   

By distinguishing fuel weight consumed in flaming and smoldering phases of combustion, the Burnup 
model allows emission factors to be applied separately to the fuel consumed in each phase.  Emission 
factors for particulate and chemical emission species (Ward et al. 1993) were applied to the fuel 
consumed in flaming and smoldering combustion assuming the values of combustion efficiencies of 0.97 
for flaming and 0.67 for smoldering.  Thus, the total is combined from the emissions calculated 
separately from fuel weight consumed in flaming and smoldering. 

In the emissions report, total emissions of PM2.5, PM10, CH4, CO, CO2, NOX and SO2 are listed, as well as 
burn duration.  If desired, however, burn intensity and emissions over time can be simulated using the 
FOFEM menu item Options>Save Burnup Emission File .  This information is suitable for use in 
predicting smoke dispersion.  
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FOFEM Emission Factors         

FOFEM assumes Flaming combustion efficiency (FCE) = 0.97 and  
Smoldering combustion efficiency (SCE) = 0.67 

In g/kg of fuel consumed:      

Pollutant Flaming Phase Smoldering Phase 

 Formula EF Formula EF 

PM2.5 67.4 - (FCE x 66.8)= 2.604 67.4 - (SCE x 66.8)= 22.644 

CH4 42.7 - (FCE x 43.2)= 0.796 42.7 - (SCE x 43.2)= 13.756 

CO 961 - (FCE x 984)= 6.520 961 - (SCE x 984)= 301.720 

CO2 FCE x 1833= 1778.01 SCE x 1833= 1228.11 

PM10
1 PM2.5 x 1.18= 3.07272 PM2.5 x 1.18= 26.71992 

NOx2 3.2= 3.2 0= 0 

SO22 1.0= 1.0 1.0= 1.0 
1 Emission factor for PM 10 is computed as 1.18 times emission factor for PM 2.5 
2 Updated September 3, 2003 

Citations 

Finney, M.A. 2001.  FARSITE help documentation. 

Hardy, C.C., Burgan, R.E., Ottmar, R.D., Deeming, J.C. 1996. A database for spatial assessments of fire 
characteristics, fuel profiles, and PM10 emissions. Unpublished paper on file at USDA Forest Service, 
Missoula Fire Sciences Laboratory, Missoula, MT. 

Ward, D.E., Peterson, J., Hao, W.M. 1993. An inventory of particulate matter and air toxic emissions 
from prescribed fires in the USA for 1989. In: Proceedings of the Air and Waste Management Association 
1993 annual meeting, Denver, CO. 19 p.  
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Appendix A:  Field Name and Description for .FFI and .TRE Files 
Produced by FFI 

Files exported from FFI can be imported into FOFEM. There will be two files (required), one with the 
fuels information (with a FFI extension) and one with the tree information (with a TRE extension). These 
files may also be manually created. Example files are included with the FOFEM installer.  

 
 

.FFI 

Field name Description 

PlotId FFI Macro plot identifier 

Monitoring Status FFI Monitoring status 

Monitoring Status Order FFI Monitoring status order 

TotalDuffLoad1 Duff load (t ac-1). From Surface Fuels protocol and/or the 
Biomass – Fuels  protocol 

DuffDepth Duff Depth (in.). From Surface Fuels protocol 

LitterLoad1 Litter load (t ac-1). From Surface Fuels protocol and/or the 
Biomass – Fuels  protocol 

LichenLoad1 Lichen load (t ac-1). From Surface Fuels – Alaska protocol 
and/or the Biomass – Fuels  protocol 

LiveMossLoad1 Live moss load (t ac-1). From Surface Fuels – Alaska protocol 
and/or the Biomass – Fuels  protocol 

DeadMossLoad1 Dead moss (t ac-1). From Surface Fuels – Alaska protocol and/or 
the Biomass – Fuels  protocol 

OneHour1 1-hr (0 - <0.25 in) woody load (t ac-1). From Surface Fuels 
protocol and/or the Biomass – Fuels  protocol 

TenHour1 10-hr (0.25 - <1.0 in) woody load (t ac-1). From Surface Fuels 
protocol and/or the Biomass – Fuels  protocol 

HundredHour1 100-hr (1.0 - <3.0 in) woody load (t ac-1). From Surface Fuels 
protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc1Sz11 Load of 3 - < 6 in. decay class 1 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc1Sz21 Load of 6 - < 9 in. decay class 1 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc1Sz31 Load of 9 - < 12 in. decay class 1 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc1Sz41 Load of 12 - < 20 in. decay class 1 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc1Sz51 Load of >= 20 in. decay class 1 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc2Sz11 Load of 3 - < 6 in. decay class 2 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc2Sz21 Load of 6 - < 9 in. decay class 2 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc2Sz31 Load of 9 - < 12 in. decay class 2 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc2Sz41 Load of 12 - < 20 in. decay class 2 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

Table A-1:  FFI file field names and descriptions. 
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ThousandHourDc2Sz51 Load of >= 20 in. decay class 2 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc3Sz11 Load of 3 - < 6 in. decay class 3 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc3Sz21 Load of 6 - < 9 in. decay class 3 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc3Sz3v Load of 9 - < 12 in. decay class 3 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc3Sz41 Load of 12 - < 20 in. decay class 3 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc3Sz51 Load of >= 20 in. decay class 3 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc4Sz11 Load of 3 - < 6 in. decay class 4 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc4Sz21 Load of 6 - < 9 in. decay class 4 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc4Sz31 Load of 9 - < 12 in. decay class 4 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc4Sz41 Load of 12 - < 20 in. decay class 4 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc4Sz51 Load of >= 20 in. decay class 4 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc5Sz11 Load of 3 - < 6 in. decay class 5 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc5Sz21 Load of 6 - < 9 in. decay class 5 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc5Sz31 Load of 9 - < 12 in. decay class 5 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc5Sz41 Load of 12 - < 20 in. decay class 5 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

ThousandHourDc5Sz51 Load of >= 20 in. decay class 5 fuels (t ac-1). From Surface 
Fuels protocol and/or the Biomass – Fuels  protocol 

HerbLoadDead Dead herb load (t ac-1). From Surface Fuels – Vegetation 
protocol  

HerbLoadLive1 Live herb load (t ac-1). From Surface Fuels – Vegetation protocol 
and/or the Biomass – Fuels  protocol 

ShrubLoadDead Dead shrub load (t ac-1). From Surface Fuels – Vegetation 
protocol  

ShrubLoadLive1 Live shrub load (t ac-1). From Surface Fuels – Vegetation 
protocol and/or the Biomass – Fuels  protocol 

ShrubLiveSAV2 Not exported from FFI 

HerbSAV2 Not exported from FFI 

WoodySAVOneHour2 Not exported from FFI 

FractionGroundAreaPile
Covered2 

Not exported from FFI  

PileLoadWholePlot1 Load of piled fuels (t ac-1) From Biomass Fuels 

  
1 If loading data for the same component exists in both protocols, the average of the two values will be exported 

out of FFI. 
2 If you enter data in these fields in the .FFI file, FOFEM will use the data.  
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.TRE 

Field name Description 

PlotId FFI Macro plot identifier 

Monitoring Status FFI Monitoring status 

Monitoring Status Order FFI Monitoring status order 

TreeSpecies Tree species code (NRCS Codes only 

TreeExpansionFactor Representative tree density (trees ac-1) 

Diameter1 Tree DBH or DRC (in.) 

TreeHeight Tree height (ft) 

CrownBaseHeight2 Live crown base height (ft) 

TreeStatus3 Tree status (L, H, U, S, D) 

CrownClass4 Crown class (D, C, I, S) 

CrownRatio5 Crown ratio (0 - 100) 
1 If values for both DBH and DRC are entered in FFI, this file will use DBH. For trees <4.5’ tall, DBH=0.1” but the 
seedlings are not imported into FOFEM. 
2 This field is populated with values in the Live Crown Base Height field in the FFI Trees-Individual protocol.  
3 Trees coded D (Dead) are valid but will not be displayed in the tree list in FOFEM. 
4 This field is ignored in FOFEM. 
5 If Crown Ratio is null then FOFEM will calculate Crown Ratio = (1 – (Crown Base Height / Tree Height)) * 100. If 
Crown Base Height and Crown Ratio fields are null the tree record will not be imported into FOFEM. 

NOTE: To convert older version TRE files so they work in FOFEM, change the extension of the tree file from TRE 
to CSV, open the file in Excel, add a column header named CrownRatio and Save the file. Close Excel, change 
the tree file extension from CSV to TRE. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table A-2:  TRE file field names and descriptions. Files exported from FFI will include tree 
data from the Trees-Individuals, Saplings and Seedlings methods but only the Individuals 
and Sapling data are imported into FOFEM.  
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Updates 

Version 6.3.1  

1. Updated soil heating logic for duff and non-duff models 

2. Updated litter and herb consumption equations, and updated some default fuel loadings for the 
southeast  

3. New pocosin duff consumption equation added 

4. FLM fuelbeds updated to match LANDFIRE attribute table 

5. Accepts new FFI file imports files that include monitoring status 
 

Version 6.2 Not released 

Version 6.1  

1. Updated NVCS and SAF default fuel loads for some shortleaf pine – oak and oak types in the 
southeast. 

2. Modified user folder location for better performance on Window 7 and 8 machines. 

3. Added ability to input fuels from FFI export files. 

Version 6.0  

1. Complete redesign of the user interface 

2. Improved graphics 

3. Mortality tree species codes changed to NVCS codes (FOFEM5 used six character codes) 

4. FCCS cover types have been updated and now include foliage and branch fuels.  

5. FFI (FEAT/FIREMON/Integrated) tree data can now be imported directly into the Mortality 
model.  

6. The soil simulation model has been refined.  

7. Added new tree mortality model for longleaf pine 

Version 5.9.1  

1. A new batch feature has been added  that allows for creating individual emission files, see Batch 
Processing 

2. A second new batch feature is the ability to more precisely set the input parameters of the 
Burnup consume model. See Batch Burnup Parameter File  

 Version 5.9 

1. Updated the FLM fuel models.  

2. Added a Burnup command line option.   See Running Burnup from an input File 

Version 5.8 

1. Program updated to use new revised FCCS fuel loading classes. 

2. FLM fuel classes added to program.  
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Version 5.7 

1. Added post-fire injury option to tree mortality window. Updated mortality models for several 
species. 

Version 5.6  

1. Feature added to allow batch input files to be run from command line, see  

 

Version 5.5 

1. Miscellaneous changes: updates to help text, minor program bug fixes   

Version 5.3 

1. Batch processing feature added. Multiple plots of input data can be processed to model fuel 
consumption, smoke emissions, soil heating and tree mortality.  

2. Unit Average Combustion Efficiency added to Smoke Emission Report.   

Version 5.2 

1. Canopy Cover estimates added to the tree mortality report. 

Version 5.1 

1. Includes additional emissions for NOX and SO2. 

2. Default moisture settings for moisture regime were changed. 

3. Problems with the Mortality Species window for the Windows 2000/XP version were been 
corrected 

Version 5.0  

1. Original Release, Windows graphic user interface version enhanced and upgraded from original 
FOFEM DOS version. 


